
Page 1

1

MacPoisson™

Instructional Finite Element Analysis
for Solving Poisson’s Equation

With the Macintosh®

J.R. Cooke, D.C. Davis and E.T. Sobel

Best Engineering
Software Award

© Copyright 1988
Cooke Publications • Ithaca, NY

All Rights Reserved

(PDF Format, Nov. 1996; Use BookMarks or Contents)                   



Page 2

2

Before you begin

Versions: The MacPoisson (MP) student version, which is limited to 300 degrees of freedom,
includes an applications disk with one or more demo projects, as well as this manual.  The
professional version has the same functional capabilities, but handles larger problems, up to
the limits of RAM.  With 1 megabyte of RAM, MP can handle more than 1,000 degrees of
freedom, depending upon the complexity of the geometry involved and the size of your
system file.

Updates: Return a copy of the Registration card from the Appendix to have your name placed
on our mailing list for notification of updates and related products.

Hardware:   MacPoisson should normally be used with a Macintosh Plus, SE or Macintosh II
and with at least two disk drives.  MP works best with generous memory and disk storage.  A
Macintosh 512KE includes the 128K ROM and supports MacPoisson, although it operates
more slowly.  This configuration is satisfactory for instructional problems.  If you have only
an internal 800K drive and no external drive, you can store a demo problem of modest size on
the program disk if you first remove all non-essential files from your working copy.

The MP code is large; in fact, it is larger than the original MacWrite, MacPaint, and MacDraw
applications combined.  This size necessitated an extended testing period.  The program is
distributed on an 800K disk.

The MacPoisson/68881 version utilizes the Mac II’s 68881 math coprocessor for a dramatic
speed improvement.  Note: Either version (with or without coprocessor support) will run on
the Mac II, but the 68881 version will only   run if your computer is equipped with the 68881
coprocessor.  Output can be printed on either the ImageWriter or LaserWriter.

System Software: MacPoisson functions properly with System file 4.2, Finder 6.0, and
MultiFinder 1.0 (and later versions) and supports adjustable window sizes for larger screens.

Protecting your investment: Before using your MP distribution disk, set the write-protect tab
on the diskette to the locked position.  Then make a working copy and store the original in a
safe place.  For your convenience we have NOT copy-protected the disk.  You may make an
archival copy using the standard copying process, and you may transfer the program to your
hard disk.  Unless explicitly covered by a written contract, MP is licensed as a single-user
product.  See the license agreement.  We have spent hundreds of hours in the development
of MP, so we appreciate your assistance in protecting our investment!

Only one copy of MP (either the co-processor or non-coprocessor version of the application)
should be left on the working disk with a current System folder.  Remove from the working
copy any files which you do not need, e.g., Laser Prep and LaserWriter drivers if you will not
be using a LaserWriter.  Remove the demo projects after you complete this chapter.  Typically,
you use an external drive to store your data files.  The program disk must not  be write-
protected during use.

If you have problems: 1) Re-read the documentation. 2) Read the supplements to the
documentation supplied with MP.  This is where we document extensions to the software or
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manual and provide hints to clarify frequently asked questions.  3) Make a reasonable effort to
resolve the problem. 4) If you need additional assistance, please write or call.  Be sure to
provide enough background (equipment, system software, MP version number and serial
number as displayed on the About menu, etc.) for us to respond.  Provide sufficient detail for
us to replicate the problem situation.  In the case of site licenses for classroom usage, all
questions should be routed through the person who obtained the site license.  No support will
be provided for stolen copies!

Getting Started: Proceed only after making your backup and storing the distribution disk.
Although an experienced Macintosh user probably could use many of the program features
without studying this manual, reading this manual should make your learning experience
more enjoyable and productive.  You might otherwise overlook some of the nifty features.  In
addition, the subject addressed by MP is likely to be more complex than most Macintosh
applications you have encountered.
Program and Text © 1986-8 Cooke Publications

Copyright

This manual and the software accompanying it and described in it are copyrighted with all
rights reserved by Cooke Publications. Pursuant to the United States copyright laws, neither
this manual nor the software may be copied or otherwise reproduced, in whole or in part,
without prior written consent of Cooke Publications, except in the normal use of the software.
Any permitted copies must include the same proprietary and copyright notices as were affixed
to the original. This exception does not allow copies of the software or manual to be made for
others, whether or not sold. Under these laws, copying includes translating into another
language or format.

License

You have the non-exclusive right to use the enclosed program. This program can only be used
on a single computer. You may physically transfer the program from one computer to another
provided that the program is used on only one computer at a time. You may not electronically
transfer the program from one computer to another via a network. You may not distribute
copies of the program or related documentation without the prior consent of Cooke
Publications. Multiple copy site licenses must be negotiated directly with Cooke Publications.

Acknowledgements:    MacPoisson™, MacElastic™, PC-Poisson™, PC-Elastic, and
MathWriter™ are trademarks of Cooke Publications. Apple is a registered trademark of Apple
Computer, Inc. Macintosh is a trademark of McIntosh Laboratory, Inc. and is used by Apple
with express permission. Macintosh "System folder" programs, if supplied, are copyrighted
programs of Apple Computers, Inc. and are distributed under license by Cooke Publications
for use only in combination with the system with which they are supplied. The MacPoisson
Program, Book, and Screen Displays © Copyright 1986-8, Cooke Publications

APPLE COMPUTER, INC. MAKES NO WARRANTIES, EITHER EXPRESSED OR IMPLIED,
REGARDING THE ENCLOSED COMPUTER SOFTWARE PACKAGE, ITS
MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR PURPOSE. THE
EXCLUSION MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH
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SPECIFIC LEGAL RIGHTS. THERE MAY BE OTHER RIGHTS THAT YOU MAY HAVE
WHICH VARY FROM STATE TO STATE.

This manual was prepared using FullWrite Professional, MathWriter, and FullPaint. The
typesetting was produced using a LaserWriter Plus with a Macintosh II.

DISCLAIMER OF WARRANTY

COOKE PUBLICATIONS HEREBY DISCLAIMS ALL WARRANTIES WITH REGARD TO
THIS SOFTWARE INCLUDING WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR ANY PARTICULAR PURPOSE (WHETHER OR NOT COOKE PUBLICATIONS HAS
BEEN ADVISED OF SUCH PURPOSE). THIS SOFTWARE IS NOT INTENDED BY EITHER
PARTY TO BE "CONSUMER GOODS" UNDER ANY STATE OR FEDERAL LAW.

NEITHER COOKE PUBLICATIONS NOR ANY INDIVIDUAL ASSOCIATED WITH THE
DESIGN OR PRODUCTION OF THE SYSTEM SHALL HAVE ANY LIABILITY OR
RESPONSIBILITY FOR DAMAGES OF ANY KIND, INCLUDING SPECIAL, DIRECT,
INDIRECT, INCIDENTAL, OR CONSEQUENTIAL, ARISING OUT OF OR RESULTING
FROM THE USE OF THE SYSTEM OR FROM ITS PERFORMANCE OR FAILURE TO
PERFORM ANY FUNCTION WHETHER OR NOT COOKE PUBLICATIONS OR ANY SUCH
INDIVIDUAL HAS BEEN ADVISED OF SUCH DAMAGES OR POSSIBILITY OF DAMAGES.
USERS RELY UPON THE SYSTEM AND ITS RESULTS SOLELY AT THEIR OWN RISK.

Limited Warranty:  Cooke Publications warrants that the manuals and the disk(s) on which
the system is recorded are free from defects in materials and workmanship under normal use
and service for a period of thirty (30) days from the date of purchase. Cooke Publications’
entire liability under this warranty shall be limited to replacement of the defective manual or
disk upon its return to Cooke Publications along with a copy of the receipt. If the failure of a
disk resulted from accident, abuse, or misapplication of the product, then Cooke Publications
shall have no responsibility to replace the disk under this warranty.

Cooke Publications, P.O. Box 4448, Ithaca, New York 14852

ISBN 0-940119-10-2
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Chapter 1

Finite Element Method Overview

Steps in the problem solving process

Finite Element Analysis is a numerical method for solving problems by breaking the physical
space into discrete “elements” for which the approximate solution is known.  The composite
of these finite elements is used to form the global solution.  Specifically, MacPoisson (MP)
solves problems governed by Poisson's equation in 2 dimensions (planar) and 3 dimensions
(problems having symmetry about an axis).

The method of solution can be broken into three main steps: First, you generate a mesh to
describe the geometry of the problem.  This corresponds to the discretization of space
mentioned above.  Next, you ascribe constraints to the problem.  These constraints include the
physical properties, as well as sources and sinks (distributed and line), and fixed potential,
fixed gradients or a linear combination of these values.  Finally, MP solves the problem,
which involves automatically forming and solving a set of simultaneous linear algebraic
equations dictated by the first two steps.  Output includes both tabular and graphical displays.
MP provides a visual framework for both input and output.

The steps require a tremendous amount of bookkeeping in order to track the position of the
mesh elements, the relationships between elements, the properties of different elements, and
the boundary conditions at nodes and elements.   The power of MacPoisson lies in its ability to
free you from these bookkeeping tasks, thus allowing you to concentrate on the problem being
modeled.

The six selections on MacPoisson's main menu follow, along with a brief description of the
function of each selection.  These steps are illustrated using two elementary examples—one
from electrostatics and the other from heat conduction.  One problem is planar, and the other
is treated as an axisymmetric problem.  One problem is formulated using one mesh
generating region; the other uses three.

This treatment is intentionally brief in order to not obscure the “big picture”.  We suggest that
you read this chapter first to develop an overview.  Chapter 2 presents step-by-step
instructions for solving these problems.  These problems are included on the distribution
disk.
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A. Heat conduction in a hollow cylinder

              
Fig 1.1 Hollow cylinder problem                 Fig 1.2 Hollow cylinder schematic

Figure 1.1 depicts a long, hollow cylinder with a 100°C inner surface and a 20°C outer surface.
The dimensions, properties, and boundary conditions are shown in Figure 1.2, which also
shows how the axial symmetry is being used.  The cylinder is represented as a rectangle
rotated about the z-axis.  We assume there is no variation in the z direction.  The temperature
distribution within the cylinder is to be found.

Fig 1.3 displays the solution we seek.  The temperature at all interior points is uniquely
determined because the solution must satisfy Laplace’s equation (i.e., a special case of Poisson’s
equation) and the conditions we specify on the boundaries.

The points of constant temperature are straight lines parallel to the inner and outer surfaces.
The lines are more closely spaced near the inner wall on the left.   (Refer to Chapter 2 for a
step-by-step guide to the solution and to Chapter 3 for a review of the exact solution.)
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Fig 1.3 Constant temperature lines in a hollow cylinder

A1. GEOMETRY - Overall body definition:  The problem space is defined and subdivided for
later processing.

Fig 1.4 Points      Fig 1.5 Regions

The geometry is defined using points, lines, and arcs (Fig 1.4).  The problem, therefore, looks
like an unfinished "connect the dots"  game prior to region definition, described next.  Several
tools aid in the rapid generation of points on lines and arcs.
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To utilize the automatic mesh generator, you must define regions (Fig 1.5) meeting specific
criteria.  The fundamental region is the curvilinear quadrilateral, a shape defined by four
vertices with each of the four sides having one intermediate point to which a quadratic curve
is fitted, for a total of eight defining points.  Complex problems have borders which cannot be
described by only one curvilinear quadrilateral.  In this case, you break the total space into
multiple regions.  The actual region generation is done by selecting the predefined points in
counterclockwise order, beginning with a vertex.  Once eight points are selected, MacPoisson
connects the points and shades the region.

A2. MESH - Mesh generation:  The automatic mesh generator takes each properly defined
region and breaks it into triangular sub-regions referred to as "elements".

    
Fig 1.6 Nodes/side             Fig 1.7 Mesh

Each element vertex is known as a "node".  The user specifies the number of nodes to be
placed on each side of a mesh generating region (Fig 1.6), with the constraint that opposite
sides of a region have the same number of nodes and that regions sharing a common
boundary have the same number of nodes on the common boundary.

For properly defined regions MacPoisson enforces these constraints automatically, creates the
mesh (Fig 1.7) and also keeps track of the coordinates of each of the generated nodes.  Facilities
to modify the mesh in other ways (i.e., slightly move a node, reorient a diagonal, subdivide
elements) are available.  When the mesh is satisfactory, the program goes through several
calculations to identify unique lines and the connectivity of line segments, as well as to
minimize the bandwidth of the global "stiffness" matrix.  This step reduces memory
requirements and reduces computational time.
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A3. PROPERTIES - Define properties and boundary conditions:

Fig 1.8 Properties         Fig 1.9 Constraints

As mentioned earlier, the solution of a MacPoisson problem involves approximating the
solution over a large number of small, connected elements.  The material properties of each
element are, therefore, crucial to the outcome of the problem.  From the properties menu,
choose the material properties section to set the element material properties, by element,
region, or whole body (Fig 1.8).  Element properties can be different along each axis direction.
Each element can contain a distributed source.

Next, prescribe the boundary conditions (Fig 1.9).  You can set fixed nodal values, nodal
sources and sinks, as well as fluxes across boundaries.  Responsibility for formulating a
meaningful, well-posed problem rests with you.

A4. SOLVE - Solution of the system of equations:

If you have completed the previous steps properly, MP forms and solves the equations which
describe the physical situation.  MP uses the Gaussian elimination technique to solve the
system of equations thereby getting the resulting nodal potential (e.g.,temperature) values.
Once MP finds the nodal potentials, you can direct the program to compute element
potentials, nodal and element potential gradient values, and boundary fluxes.

A 5. PLOT - Plot results:
 MacPoisson produces equipotential plots (Fig 1.10) and shaded element potential plots (Fig
1.11).  You can control the resolution to focus on a particular section of the problem.
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Fig 1.10 Properties                     Fig 1.11 Constraints

You can produce both diagnostic and presentation quality plots.  MP provides labeling of
nodes, elements, contours, average values,  in addition to text.  Zooming capabilities allow
you to refine the plots as needed.
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A6. LIBRARY - Project creation and data examination:

You can examine the tabular output from within MP (Fig 1.12), as well as with a word
processor.  With the output data you can compute other interesting properties.

Fig 1.12 Tabular Output

Use the Library to also examine the input and the intermediate calculation steps.  The library
also enables you to generate input files without graphical support (in order to study the details
of the process) or to produce a specialized custom mesh.

The electrostatics example which follows parallels the heat conduction example just described,
but illustrates a different use of Laplace’s equation, a planar problem, and a multiple region
mesh generation.  To the extent possible, the text repeats the previous discussion.
Alternatively, you can skip the electrostatics example and proceed to the step-by-step tutorial
in chapter 2.
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B. Electrostatic potential between two eccentric cylinders

Fig 1.13 Eccentric cylinder

(0,0) (1,0)             (4,0) (5,0)         (7,0)          (10,0)
Fig 1.14 Schematic of eccentric cylinder

Figure 1.13 depicts two circular metal  cylinders of different radii and different centers, one
lying completely within the other.  The voltage on the inner cylinder is taken to be 200 volts,
while the outer is taken to be 0 volts.  The dimensions, properties, and boundary conditions
are shown in Figure 1.14. You are to find the potential distribution between the cylinders.
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Fig 1.15 Constant Potential Lines

The potential at all interior points is uniquely determined because the solution must satisfy
Laplace’s equation (i.e., a special case of Poisson’s equation) and the conditions  you specify on
the boundaries.  The constant potential lines (Fig 1.15) are eccentric cylinders.  See Chapter 2
for step-by-step solution procedures and Chapter 3 for a discussion of the theoretical solution.

B1. GEOMETRY - Overall body definition:  The problem space is defined and subdivided for
later processing.

Fig 1.16 Points
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Fig 1.17 Regions

The geometry is input as points, lines, and arcs.  The problem (Fig 1.16), therefore, looks like
an unfinished "connect the dots"  game.

In order to utilize the automatic mesh generator, you must define regions (Fig 1.17) meeting
specific criteria.  The fundamental region is the curvilinear quadrilateral, a shape defined by
four vertices with each of the four sides having one intermediate point to which a quadratic
curve is fitted, for a total of eight defining points.  Complex problems have borders which
cannot be described by only one curvilinear quadrilateral.  In this case, once you have entered
all the points defining the entire problem space, you break the total space into multiple
regions.  The actual region generation is done by selecting the predefined points in
counterclockwise order, beginning with a vertex.  Once eight points are selected, MacPoisson
connects the points and shades the region.

B2. MESH - Mesh generation:  The automatic mesh generator takes each properly defined
region and breaks it into triangular sub-regions referred to as "elements".

Fig 1.18 Nodes per side
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Fig 1.19 Mesh

Each element vertex is known as a "node".  You specify the number of nodes to be used in
each mesh generating region (Fig 1.18), with the constraint that opposite sides of a region have
the same number of nodes and that regions sharing a common boundary have the same
number of nodes on the boundary.

For properly defined regions, MacPoisson enforces these constraints automatically, creates the
mesh (Fig 1.19), and also keeps track of the coordinates of each of the generated nodes.
Facilities to modify the mesh in other ways (i.e., slightly move a node, reorient a diagonal,
and subdivide elements) are available.  When the mesh is satisfactory, the program goes
through several calculations to identify unique lines and the connectivity of line segments, as
well as to minimize the bandwidth of the global "stiffness" matrix.  This step reduces memory
requirements and reduces computational time.

B3. PROPERTIES - Assign properties and boundary conditions:

Fig 1.20
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Fig 1.21 Conatraints

As mentioned earlier, the solution of a MacPoisson problem involves approximating the
solution over a large number of small, connected elements.  The material properties of each
element are therefore crucial to the outcome of the problem.  From the properties menu, you
choose the material properties section to set the element material properties by element,
region  (Fig 1.20), or whole body.  Element properties can be different along each axis direction.
Each element can include a distributed source term.

Next, you prescribe the boundary conditions (Fig 1.21).  You can prescribe fixed nodal values,
along with nodal sources and sinks, as well as fluxes across boundaries.  Responsibility for
formulating a meaningful, well-posed problem rests with you.

B4. SOLVE - Solution of a system of equations:

If you have completed the previous steps properly, MP forms and solves the equations which
describe the physical situation being modeled.  This part of the program uses the Gaussian
elimination technique to solve the system of equations thereby getting the resulting nodal
potential values.  Once MP solves the nodal potentials, you can direct the program to compute
element potentials, nodal and element potential gradient values, and boundary fluxes.
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B5. PLOT - Plotting results:

Fig 1.22 Element average potential plot

MP graphically displays the output in the form of equipotential plots and shaded element
potential plots (Fig 1.22).  You can change the resolution to focus on a particular section.

You can generate diagnostic plots and plots suitable for publication.  Labeling of nodes,
elements, contours, and average values is provided, in addition to text labels.
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B6. LIBRARY - Create projects and examine data:

You can examine the tabular output from within MP (Fig 1.23), as well as with a word
processor.  With the output data you can compute other interesting properties.

Fig 1.23 Tabular output

Also,use the Library to examine the input and the intermediate calculation steps.  The library
also enables you to generate input files without graphical support (in order to study the details
of the process) or to produce a specialized custom mesh.

If you skipped the heat conduction example, you may wish to review it before proceeding to
the demo exercise.
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Chapter 2

MacPoisson™User’s Guide

Macintosh Basics

This section on Macintosh Basics contains only background information and can be skipped
by the experienced user.  In the manual we assume that you are already familiar with the
Macintosh computer and application programs such as MacWrite™, MacPaint™, and
MacDraw™.    As a result of our following the Macintosh protocols, we hope that you can
concentrate more comfortably upon the content of the finite element method, rather than
upon the vehicle used to present this powerful technique.

The program provides an immediate visual indication that it is performing your command.
Computation-intensive commands are accompanied by banners or other visual indicators of
the progress of your analysis.

We have provided multiple paths through the analysis so that you may proceed in the most
comfortable and intuitive manner possible, given the fundamental constraints of the
algorithms.  At any stage in the analysis we show in normal print on the screen all
permissible steps in a menu, while non-permissible options are dimmed and disabled.  In
addition, we present the most probable next step as the default, indicated by a darkened border
of the button.

The Macintosh supports an extensive and elegant use of graphics which, we think, makes it
an excellent instructional vehicle for the finite element method.  The problem formulation
phase, if done without graphics support, requires the tedious and error-prone preparation of
text files of tabular data. Similarly, interpretation of the massive tabular results is difficult and
less comprehensible without graphics.

Let's briefly review some of the most important Macintosh topics which are used in the
discussion which follows. The basic assumption of the Macintosh interface is that language-
independent pictures are a more convenient means of communicating than words.  The use
of pictures is facilitated by the mouse pointing device.

Your Macintosh screen is regarded as an electronic representation of your desktop.  You can
rearrange the items on the screen with the mouse which has three basic actions:
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Clicking  - Position the pointer (of whatever shape) to the desired location by moving the
mouse and then briefly pressing and releasing the mouse button without moving the mouse.
Double-click  in quick succession to extend the action of the first click (e.g., to select and open a
file).

Pressing - After positioning the pointer, hold down the mouse button without  moving the
mouse.

Dragging - Position the pointer with the mouse and, while holding down the mouse button,
move the mouse to a new location and release the button.

The Cursor: The cursor shape changes depending on its function.  An arrow is the most
common shape and is used to press the scroll bars, the size box, the title bar, etc.  An I-beam
pointer indicates the placement of text entered from the keyboard.  The cursor becomes a thin
"plus" sign when used to select an area to be enlarged in a zoom operation or to select a
contiguous group of objects to be acted upon.  A wristwatch shows that a lengthy operation is
in progress.

Selecting

You must select an object before you can perform an operation on it, but selection itself has no
effect on the object and can be undone.  Simply place the cursor on an object and click to select.
Double clicking (clicking twice in succession without moving the mouse) extends the effect of
a single click.  For example, double clicking on an icon not only selects that item but also
instructs the program to run or execute that item.

You can select a range of objects.  Position the pointer at one corner of a rectangular area you
wish to select and then drag the pointer to the diagonally opposite corner and release the
button.  A rectangle shows the outline of the range you selected.  When you work with the
finite element method, you use this feature to erase multiple geometry definition points.  You
can change the extent of a selection by holding down the shift key and clicking the mouse
button.  For example, to apply the same boundary condition along a contiguous range of the
boundary in MacPoisson, simply shift-click the beginning point, keep the shift key pressed,
and then (moving in a counterclockwise direction around the boundary) shift-click the
ending point.

When you wish to select a rectangular portion of a plot in MP for enlargement, press the
option key to turn the cursor into a plus, then drag to select an area for enlargement.  With
the option key still pressed, click inside the area to initiate the zoom.

You can select and edit text and numeric entries just as you do in MacWrite.  Simply place the
pointer and click the mouse to fix the insertion point.  The I-beam pointer automatically
appears enabling you to insert typed characters.  To remove characters, select them by dragging
or shift-clicking and press the backspace key or begin typing to delete the selected material and
to insert new characters.
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Windows

The electronic equivalents of rectangular pieces of paper on the desktop are called windows.
Several windows can be visible or partially visible on the desktop at one time.

Fig 2.1 Windows

Windows have some or all of the features shown in Fig 2.1.  You can enter commands only in
the active window, i.e., the window highlighted with ruled lines across the top.  The active
window is the front window, and it has a centered title.  Click in the window to make it
become the active window.  If the window is too small to enable you to view the entire
document and if it has a size box at the bottom right corner, you can change its size by
dragging the size box.  If necessary, re-position a window by dragging the window by the title
bar.  If you still cannot view the entire document, use the vertical and/or horizontal scrolling
bars. Click on a scroll arrow to scroll a line or a character at a time.  Press on an arrow to scroll
continuously.  Drag the scroll box to move larger distances, or click in a scroll bar on either
side of the scroll box to scroll a screen at a time.

At the top left corner of most windows is a close box. Click in the close box to make the
window go away; alternatively, choose Close from the File pull-down menu bar at the very
top of the screen.  (You either save or regenerate the information in the screen if you
subsequently reopen the window.)

You also encounter dialog and alert windows.  An alert notifies you that an unusual situation
has occurred or that you need to make an important decision.  For example, if you are leaving
the program, an alert window (Fig 2.2) reminds you to save any data files which you would
otherwise lose.  You must click on a button; the program indicates the usual or preferred
response as a default by boldly outlining that button.
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Fig 2.2 Alert Window

There are three types of buttons:  check boxes, radio buttons, and push buttons (Fig 3.3).  Check
boxes are square boxes followed by a description.  Check boxes act as toggle switches which you
can click on or off.  You can select any number of check boxes.  On the other hand, the circular
radio buttons, so named because of their similarity to car radio station preset buttons, occur in
groups, and you can select only one.  Selecting one radio button automatically deactivates the
previous selection.  You can activate or deactivate any radio button or check box by clicking
the button or clicking within the message associated with the button. In addition to check
boxes and radio buttons, you have two other control types: small rectangular objects labeled
with text for which you simply click or press the button to perform the action, and an analog
device called a dial that is similar to the scroll bars mentioned above.

Fig 2.3 Buttons

Dialog boxes allow you to complete a command or choose a set of options. For example,
printing requires you to make some additional choices to complete an unambiguous action.
Similarly, a "Save as ..." command requires you to select a file name and possibly a drive.
Many commands have an undo or cancel option.  Re-click an icon tool to undo.
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If the foregoing discussion was not a review, we recommend that you take a few moments to
review your Macintosh owner's manual and to practice using your word processor.

A Map of MacPoisson Usage

Main Menu

     Open a Project (or Create Project via Library)

     Geometry Definition

     Mesh Generation

     Property and Constraint Assignment

     Solve

     Plot Results

     Library

Fig 2.4 The structure of MacPoisson

Fig 2.4 depicts the organization of the major parts or modules of MP.  In the following two
examples you will explore each of the modules.

Illustrative Examples

In this chapter we present in tutorial format the step-by-step details for the worked examples
presented in the overview in Chapter 1.  Chapter 3 presents a complete description of all MP
commands, including those mentioned in this chapter, and provides complete procedural
details using an example.

Typographic Convention:   
• A bullet (•) denotes a step to be executed.

MacPoisson can solve scalar potential problems governed by Poisson’s equation regardless of
the physical application of the equation.  Because we intend this to be a first introduction to
the FEM, we shall provide two demonstration examples in parallel: a steady state heat
conduction problem and an electrostatics example.  Explicit solutions exist for both.

Heat Conduction ExampleElectrostatics Example
•  2-dimensional •  axisymmetric
•  1 mesh region •  3 mesh regions
•  straight sides •  curved sides
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The two examples from the overview chapter are presented in parallel; when the text or
figures differ, both are presented—heat conduction on the left and electrostatics on the right.

Example A. Heat conduction in a hollow cylinder

Fig 2.5 Cylinder                   Fig 2.6 Cylinder in cross-section view

Fig 2.5 depicts a hollow cylinder with a 100°C inner surface and a 20°C outer surface.  The
dimensions, properties, and boundary conditions are shown in Fig 2.6 which also shows the
axial symmetry being used.  The cylinder is represented as a rectangle rotated about the z-axis.
You are to find the temperature distribution within the cylinder.

Generalizations: You can also specify flux and film coefficient boundary conditions.  The
thermal conductivity also can vary from element-to-element and the r and z components can
be different.  Line and distributed sources also can be included.

Example B. Electrostatic potential between two eccentric cylinders

Fig 2.7 Eccentric cylinders
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Fig 2.8 Schematic of eccentric cylinder

You want to compute the electrostatic field between two long eccentric cylindrical conductors
at two different potentials (Fig 2.7).  Because of the use of symmetry, two surfaces have a zero
flux and two surfaces have a specified potential (Fig 2.8).  You will compute the constant
potential lines and find the electrostatic gradients.  Each problem formulation should begin
with a sketch of the geometric and physical properties required for a complete formulation
and if the complexity justifies it, a sketch of the mesh generation process.

Generalizations: In this example you assume that the permittivity of the space between the
cylinders is uniform, although that assumption easily could be relaxed.  Furthermore, the
program could include either line or distributed space charge.

1. Start your computer and activate MP.

• Double click the MP icon.

• When the copyright notice appears, click to continue.
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Fig 2.9 Program credits and copyright notice

The Main menu allows you direct control of MP.
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Fig 2.10 The main menu

Problem formulation can begin when the main menu appears.  The phases of problem
formulation, solution, and output are represented in the main menu by the steps which you
execute sequentially. See Fig 2.4 also.

• Check Demo Mode on the  menu (Fig 2.11) to suppress all file saving.

Fig 2.11 Apple Menu

The presence of the check mark indicates that you are in demo mode.  You can enter and
leave Demo Mode at any time and as often as you wish; simply select Demo Mode to toggle.

Important: In Demo Mode all file saving is suppressed; this allows you to explore various
options at each stage of the analysis without corrupting the data files.  If you fail to select
Demo Mode at this point you may not be able to follow the instructions in the remainder of
the following exercise.  Conversely, if you are in Demo Mode, you cannot solve an original
project.
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2. Select a project.

•  Click on the long Open Project button on the Main menu (or on the File menu) (Fig 2.10).

• Change drives and folders, if necessary, to select either the heat conduction demo (Cylinder)
or the electrostatics demo project (Eccentric Cylinder) (Fig 2.12).  All of the MP files pertinent
to a project must be kept in the same folder.

Fig 2.12a Select a project

Fig 2.12b Select a project

• Double click the project name (or select the project name and click Open).

The Open Project button on the Main Menu (Fig 2.10) changes to
Close Project.
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• Double click the Geometry button (Fig 2.10) or anywhere within that label (or select
Geometry and click the Run button), and the next dialog box appears.

Fig 2.13 Existing data alert

• Click Edit to use the existing demo file (Fig 2.13).

Your choice of “Edit” assures that the existing data becomes the default.

 Fig 2.14a Select coordinate system

Fig 2.14b Select coordinate system

• Click OK to select the default coordinate system for the demo (Fig 2.14).
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Planar uses Cartesian coordinates (x,y) and assumes no change in the z-direction.
Axisymmetric uses cylindrical coordinates (r,z) and assumes no change in geometry or
constraints with respect to angular position about the z axis of symmetry.

 Fig 2.15a Set axes endpoints

Fig 2.15b Set axes endpoints

• Click OK to accept the demo values.
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You can edit the fields just as you would in your word processor.  Use the Tab key or the
mouse to move to the next field.  Should you later wish to change these limits to achieve a
zoom effect, i.e., enlargement, without destroying the problem, you can recall this window
from the Axes pull-down menu (Fig 2.16).  If you wish, change the values to enlarge different
portions of the screen but restore the original values.  

You must assure a consistent set of units throughout the project!

Note: Since you are in Demo Mode, any changes you make will affect only this module,
i.e.,Geometry.  You can explore without disturbing the tutorial.

3. Define mesh generating regions.

Figs 2.16a,b show the tool palette and completed regions.

Fig 2.16a Geometry palatte and work area
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Fig 2.16b Geometry palatte and work area

The geometry creation occurs in two phases:  Phase 1 entails creating of an outline of the
problem (points representing endpoints and midpoints of line segments comprising the
problem).   Phase 2 involves selecting these points in an appropriate manner to create regions.
See the section on region creation in Chapter 3 of this manual for details.  This process must
anticipate the next mesh requirements, perhaps the most subjective and difficult step in MP.

Scan the following  brief description of the tools; Chapter 3 provides the details.

  Point generation icon,  when selected, allows you to place single points anywhere in
the problem space.  In mouse mode, the mouse controls the point position, and clicking
assigns a point at the current mouse position.  In keyboard mode, you type the coordinates of
the point, and then click the OK box.

 Line generation icon, shown activated (inverse video), when selected, allows
generation of multiple collinear points.  You can use the mouse to specify starting and ending
points, with the number of intermediate points preselected on the keypad in the lower left
corner of the screen.  The keyboard mode allows numerical input of starting and ending
coordinates followed by keypad selection of the desired number of intermediate points.  You
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can also connect existing points (either mode) by moving the mouse to the starting point and
clicking, then to the ending point and clicking.

 Arc generation icon, when selected, allows creation of circles (keyboard or mouse
mode) or of ellipses (mouse mode only).  Any portion of a circle or ellipse is also possible.
Keyboard mode prompts you for numerical input of the center point, starting point, and
degrees of rotation.  It also allows you to specify any or all of these by selecting existing points
with the mouse.  Mouse input uses a diagram to select type (circle or ellipse), degrees of
rotation, angular direction, center point, and radius.

 Delete point icon, when selected, enables you to delete existing points by simply
moving the cursor over the point and clicking.  You can remove entire ranges of points by
holding down the mouse button while moving the mouse from one corner of the offending
rectangular area to the opposite corner, thus boxing all the points which should be deleted.  A
single click inside the selected box then removes all interior points.

 Move point icon, when selected, allows you to move an existing point to a new
location.  When you click on the point to be moved, MacPoisson replies by displaying the
point's coordinates and causing the point to blink.  This verifies your selection and offers two
ways to move the point:  dragging the blinking point to a new location or typing new
coordinate values into the existing ones.  Click on the screen to accept the change.

 Region selection icon, when selected, places MacPoisson in the region selection mode,
where you use the mouse to select existing points in counterclockwise order to create regions
which enable the automatic mesh generator to work properly. (See details in Mesh
Generation section.)  Briefly:  All regions are comprised of four sides, each defined by two
endpoints and one intermediate point, to which a quadratic curve is fitted.  If the midpoint is
collinear with the endpoints, MP creates a straight line.  The total number of points in a
region is therefore eight.  To select a region, invoke the region generation icon and move the
cursor to a vertex of your proposed region.  Click on the vertex, move the cursor to the closest
counterclockwise point in the region, and click again.  Repeat this until all eight points have
been selected.  MacPoisson now shades the region, verifying your choice.  Notice in Fig 2.16b
that if you use multiple regions, all three points on a common side must be shared by adjacent
regions to assure a common boundary!

 Region deletion icon,  when selected, enables you to remove incorrectly defined or
otherwise unsatisfactory regions.  Simply select this icon, move the cursor over the region
you wish to remove, and click.
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Let’s continue with the demo examples.

• Click the Region deletion icon, and then click within a region.

• Click the Region selection icon and redefine the region (Fig 2.17).

Fig 2.17 Region definition

Optional:  To gain experience with the other tools, delete the region(s) and practice adding
points, deleting individual points and groups of points, and adding points on lines and arcs.
See above for instructions or turn to the Reference Chapter 3.

If you encounter difficulty recreating the regions, you can either abandon your results because
you are in demo mode or return to the main menu (File menu) and re-enter this module.

When you have completed exploring this module,

• select Mesh from the File menu to continue or
• select Quit from the File menu to terminate the session.

Note: To avoid corrupting your files, never simply turn the power off in the midst of a
project.

If you were not  in Demo mode, MP would ask you if you wanted to save the data.  You could
specify either text or binary format.  Using the binary format reduces file access time but does
not immediately allow you to review the file contents.  (Refer to the discussion of this in the
Library module in the Reference chapter.)
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4. Create the mesh.

You can enter the mesh module from the main menu (Fig 2.10) or as a continuation from the
geometry module above.

Fig 2.18 Mesh module entry

The mesh module has two phases: the automatic mesh generator 1) takes each properly
defined region and breaks it into triangular areas referred to as "elements" (Generate Mesh)
and 2) automatically renumbers the element vertices, referred to as nodes, to improve
computational efficiency (Other Calculations).  Check marks indicate that these calculations
have been completed in the demo examples.  If a project had not already been selected, you
would be required to do that at this point.  Mesh (Fig 2.18) allows you to branch to other parts
of MP.
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4.1 Generate a mesh.

• Click Generate Mesh (Fig 2.18).

Fig 2.19 Nodes per side (Cylinder)

Your first task is to specify the mesh refinement appropriate to this problem.  In general, a
mesh with a larger number of smaller elements produces better numerical results than a
mesh with fewer, but larger, elements.  On the other hand, a larger number of elements leads
to a larger number of unknowns and, therefore, to a larger number of equations.  This, in
turn, requires more computer memory and requires increased computational time.  The
verification studies in Chapter 3 provide some guidance on this important, subjective process.
In more complicated problems you reduce the element size in the vicinity of greatest
anticipated change in the dependent variable, i.e., nodal potential.  Conversely, you can make
the elements larger where the expected change is smaller.

To specify the number of nodes along a side of the mesh generating region,
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Fig 2.20 Mesh (Cylinder)

• Click within the small rectangle on a region side (Figs 2.19 and 2.21).

The opposite side is located automatically.  If multiple mesh generating regions are being used
(Fig 2.21), MP identifies all sides which must share this value.

• Click on the table at the top-left corner of the nodes per side window (Figs 2.19, 2.21) to
assign the value.

The heat conduction example has 10 by 20 vertices (Figs 2.19 and 2.20) and the electrostatic
example (Figs 2.21 and 2.22) has 9 by 13, 9 by 11, 9 by 9.  The number of equations required for
these meshes is 200 and 279, respectively, as indicated by the degrees of freedom (DOF)
displayed.

By the way: The student version is limited to 300 DOF.  In the elasticity program, MacElastic,
each node has two unknowns, the displacement components,  rather than one potential at
each node.

Elements are joined only at their nodes.  Therefore, when you specify the number of nodes
you want to use on a side of a mesh generating region (Figs 2.19 and 2.21), MP enforces the
constraint that opposite sides of a region have the same number of nodes and that regions
sharing a common boundary have the same number of nodes on the boundary.  MP calculates
the nodal coordinates and element connectivity.
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Fig 2.21 Nodes per side (Eccentric Cylinder)

• Click Generate (Figs 2.19 and 2.21).

Tools to modify the mesh in various ways (i.e., slightly move a node, reorient a diagonal,
subdivide elements) are available.
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Fig 2.22 Mesh (Eccentric Cylinder)

Optional: Explore the aids listed on the Goodies menu; otherwise, skip to 4.2 Other
Calculations.

• Select Label elements or Label nodes from the menu to identify the node and element
numbers.

• Reselect the command to remove the numbering.

If the numbers are too close to read, enlarge that portion or zone of the mesh.

• Press the option key and the cursor changes to a plus sign.

• Identify (Fig 2.23) the area to be enlarged by dragging a rectangle with the mouse.
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Fig 2.23 Zoom node numbers

• Option-click (i.e., press and hold option key and click) in the rectangle to redraw the area as
large as the screen size permits (Fig 2.23).

• Click the close box on the zone window or select a different window using the Windows
menu.

• Select Modify Mesh from the Goodies menu.
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To redefine elements (the default mode),

• Select two adjacent elements and click Redefine (Fig 2.24) to switch the diagonal.

Fig 2.24a Redefine elements

Fig 2.24b Redefine elements

To move a node to a new location (Fig 2.25),

• Select Move nodes and enter the new position by keyboard or by mouse.

To use the mouse click (or press for repetition) in the corners of the diamond; click on Home
to restore the initial position.
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Note: Don’t click OK until you are ready to leave Modify.

Fig 2.25a Move nodes

Fig 2.25b Move nodes

To add a node by subdividing two adjacent elements (Fig 2.26),

• Select Add nodes,

• Select the endpoints of the common side, and

• Click Add.
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Fig 2.26a Add nodes

Fig 2.26b Add nodes

Note: None of the above modifications will be retained beyond the Mesh module because you
are in demo mode.

• Click OK to leave Modify mesh of the Goodies menu.

• Select End Generation from the Generate menu.

The Mesh module screen (Fig 2.18) reappears.

4.2 Other Calculations.

• Select Other Calculations (Fig 2.18).



Page 45

45

A bandwidth reduction (Fig 2.27) option allows you to use the Collins algorithm to renumber
the nodes to reduce the bandwidth or to use the existing node numbering.  Bandwidth
reduction is especially useful with multiple regions and mesh refinement situations.  See
Chapter 3 for a discussion of this topic.

Fig 2.27 Bandwidth reduction option

• Select Continue.

After the calculation is completed,

• Click the OK button which appears at the bottom left corner of the screen.
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Fig 2.28 Bandwidth reduction

MP automatically goes through several calculations to remove duplicate plot lines (e.g., a side
common to two adjacent elements), to find boundary nodes and elements, and to determine
the connectivity of elements.

When the results have been reported, you have completed exploring this module,

• Select Properties from the File menu or click the >>Properties button (Fig 2.18) to
continue, or

• Select Quit from the File menu to terminate the session.

Note: Never simply turn the power off in the midst of a project

If you were not in Demo mode, MP would ask you if you wanted to save the data files.  You
could specify either text or binary format.  See the Library module in the reference chapter and
the appendix for a description of these files.

5. Assign constraints.

You can enter the properties module from the main menu (Fig 2.10) or as a continuation
from the previous mesh module.
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Fig 2.29 Properties module entry

This module handles two major tasks: 1) entering and editing element properties [Enter (or
Edit) Properties], and 2) entering and editing conditions at boundary and interior nodes [Enter
(or Edit) Boundary Conditions].  Distributed source and sink conditions use the same input
structure.

“Enter” indicates the creation of a new file and “Edit” indicates revision of existing files, as in
this demo.  If you had not already selected a project, you would be required to do that at this
point.  Buttons (Fig 2.29) allow you to branch to other parts of MP.

5.1 Properties.

• Click Edit Properties (Fig 2.29).

• Click Edit (Fig 2.13) to retrieve the existing data files in the demo.

The properties palette (Fig 2.30) contains 14 shading patterns with which numerical values
can be associated.  Shades indicate the property assignment.
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Fig 2.30 Properties by palatte: cylinder

• Click to the right of a pattern to establish a cursor.

• Enter a value.

• Click on the pattern square.

• Click to assign that value.
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Fig 2.31 Multiple properties (by element)

Optional:

• Select uniformity by Element from the Uniformity menu.

• Assign values to the shades and then assign the shades to the elements by clicking or
dragging (Fig 2.31).

The process is the same for both examples.  However, different properties are involved (Fig
2.32).  For heat conduction the parameters are r and z conductivity and heat per unit volume;
for electrostatics the properties are x and y permittivity and charge per unit volume.  The
thickness is relevant only for planar problems.
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Fig 2.32 Properties menus

In the multiple region electrostatic problem (Fig 2.33), the properties were assigned to each
mesh generating region.  When entering properties for an isotropic material (x and y or r and
z property components are the same), keep the command key (cloverleaf) pressed when you
select the second component, and a copy of the assignments for the first component is copied
to the second.

Fig 2.33 Properties palatte: eccentric cylinder

• Select End Property Definition from the Properties menu (Fig 2.32) to return to the
Properties module menu (Fig 2.29).
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5.2 Boundary Conditions.

• Select Edit Boundary Conditions (Fig 2.29).

• Select Edit (Fig 2.13) to use the demo default data.

The boundary condition tools are on the palette (Fig 2.34).

Fig 2.34 Boundary conditions (cylinder)

  Line or ring source

  Nodal potential

  Surface flux

  Convection (heat)

  Eraser (applies to the tool type selected)
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When you select a surface flux or convection condition, specify the component direction too.

Fig 2.35 Boundary conditions (eccentric cylinder)

  x or r direction component

  y or z direction component

  normal component

To review the assigned values,

• Drag the cursor over the boundary condition icons on the plot to review the nodal values.

When you have selected the line source or nodal potential, MP echoes the nodal conditions
when the cursor is placed on a node; if you have selected the surface flux or convection, MP
echoes the surface conditions of the element face when the cursor passes over the midface
marker.

Optional:
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To assign boundary conditions individually, select the boundary condition type, assign
numerical value, and then click to assign the condition to the plot.

To assign conditions to a range of consecutive points along a boundary, keep the shift key
pressed and click on the first and last point in counterclockwise order.  A range indicator

 appears at the top left of the window.

When you have completed exploring this module,

• Select End Boundary Condition from the boundary condition (B.C.) menu (Figs 2.34 or 2.35)
to return to the Properties menu (Fig 2.29).
 or
• select Quit from the File menu to terminate the session.

If you were not  in Demo mode, MP would ask you if you wanted to save the data.  You could
specify either text or binary format.  See the Library module in the reference chapter and the
appendix for a description of these files.

• Click Solve on the Properties menu (Fig 2.29) to advance to the next module.

6. Form and solve the equations.

You can enter the solve module from the main menu (Fig 2.10) or as a continuation from the
properties module (Fig 2.29).  Note: For the heat conduction example, “Temperature” replaces
“Potential” on the menu.

Fig 2.36 Solve module menu
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Each of the three solve options are examined in sequence.

• Select Solve Nodal Potentials.

MP asks you whether you wish to store intermediate calculations.  Usually these are not
needed, require additional storage on the disk, and slow the process.  For instructional
purposes you should examine these files in order to examine the computational processes.

Fig 2.37 Save intermediate calculations?

• Click No (Fig 2.37).

MP formulates the system of equations—forms the equations and applies the boundary
conditions in the order listed.
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Fig 2.38a Solve for nodal potentials (or temperatures)

Fig 2.38b Solve for nodal potentials (or temperatures)
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• Click OK (Fig 2.38) when MP has completed the calculations.

• Select Solve Potential (Temp.) Gradients (Fig 2.36).

Fig 2.39a Calculate potential gradients
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Fig 2.39b Calculate potential gradients

• Click OK (Fig 2.39) when MP has completed the calculations.

• Select Other Calculations (Fig 2.36).
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Fig 2.40a Other calculations

Fig 2.40b Other calculations
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• Click OK (Fig 2.40) when MP has completed the calculations.

Note: The potential gradients and other calculations may not be required in all problems and
can be omitted.

When you are ready to plot the results,

• Select Plot (Fig 2.36).
 or
• Select Quit from the File menu to terminate the session.

If you were not  in Demo mode, MP would save the data files in binary form.   See the Library
module in the reference chapter and the Appendix for a description of these files.

7. Plot data.

You can enter the plot module from the main menu (Fig 2.10) or as a continuation from the
solve module above.

The Plot menu bar contains several options.

    
Fig 2.41 Plot menus

The File menu (Fig 2.41) contains the expected Open Project..., Close Project, Main Menu,
Library and Quit commands.  The Save Picture...  command allows  you to save the larger
plots (described below) as MacPaint files.  You can save the smaller screen size figures as
MacPaint files using the customary command-shift-3 instruction.  Use the Save Picture...
command on the file menu to save the larger pictures.  You can print the larger plots from
within MP in draft and high quality modes on the ImageWriter.  Use Print Final with the
LaserWriter.

Plot provides two classes of output: diagnostic and presentation quality (i.e., screen size and
8x10 page size).
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For each of the two sizes there are six available plots (Fig 2.41).  A sample plot from the heat
conduction example illustrates these plots.

7.1 Screen size plots.

The first (Fig 2.42) simply displays the mesh you have seen earlier.

Fig 2.42 Generated mesh
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The second (Fig 2.43) displays the boundary conditions.

Fig 2.43 Boundary conditions

Press on the boundary condition constraint icon to instruct MP to display the value.
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Contour plots (Fig 2.44) reveal the computed constant potential lines.

Press on a contour to display the value.  With the Digits command on the Style menu you can
set the format of the display.

Fig 2.44 Nodal potentials

The average potential for each element is depicted by the shading pattern (Fig 2.45).

Press on an element for MP to look up the element number and the average potential of the
element.  You can set the display format using Digits on the Style menu.
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Fig 2.45 Average element potential
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The nodal potential gradient (Fig 2.46) is displayed as contour lines.

Fig 2.46 Nodal potential gradients

Press on contour for MP to lookup the value.  You can set the display format using Digits on
the Style menu.
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The element potential gradient (Fig 2.47) is related to a shading pattern.

Fig 2.47 Element potential gradients

Press on an element for MP to lookup the element number and the element gradient.  You
can set the display format using Digits on the Style menu.
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7.2 Larger plots.

A description of the techniques to produce the larger plots is not necessary for this quick start
tutorial; we present detailed instructions in Chapter 3.  For completeness, we show screen
dumps for the electrostatic example (Figs 2.48-2.53).

Fig 2.48 Mesh with selected node numbers
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Fig 2.49 Boundary conditions with selected labels
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Fig 2.50 Nodal potentials
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Fig 2.51 Average element potentials
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Fig 2.52 Nodal potential gradients
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Fig 2.53 Element potential gradients

When you have explored the various plots,

• Select Library from the File menu (Fig 2.41).

8. Tabular results.

You can reach this module from the Main menu (Fig 2.10) as well as from the Plot module.

The File menu (Fig 2.54) contains the expected Open Project..., Close Project, Main menu, and
Quit commands.
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Fig 2.54 Library Menus

Use New Project... to initialize a new project, as described in Chapter 3.

Duplicate Project... allows you to extract the input files of the Open Project to become the
beginning point for a variation on the existing project.

Both the ImageWriter and LaserWriter are supported.

In this tutorial we simply display typical numerical results of the demo projects.  For detailed
instructions refer to Chapter 3 and to the Appendix for the file format.

The project status, which is visible when you enter this module (Fig 2. 55), lists the files.
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To examine the contents of a file,

• Double-click on the file name (Fig 2.55).

Note: The files you saved as standard text files (i.e., those with a “T” in the “Exists” column)
can also be examined using a word processor.

Fig 2.55 Project status

Use the scroll bars to review the contents (Fig 2.56).
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Fig 2.56 Nodal potential file

• Click the close box to return to the list of files (Fig 2.55).

Either,

• Examine other files,
 or
• Select Quit from the File menu (Fig 2.54).

Congratulations!  You are now ready to begin using MacPoisson.  Chapter 3 is a detailed
Reference Guide to the operational aspects of MP.  Chapter 4 is a guide to the computational
details.  Chapter 5 is a collection of solved problems.
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Chapter 3

MacPoisson Command Reference

Command Summary
About MacPoisson..., About Project..., Help, Demo Mode

Module
Submodule

Pull-down menus:
Main File: Open Project..., Close Project, Quit

Geometry File: Open Project..., Close Project, Main Menu, Mesh, Quit
Axes: Limits..., Type...

Mesh File: Open Project..., Close Project, Main Menu,Properties, Quit
Generate Mesh

Generate: Generate Mesh, End Generation
Windows: Hide all windows, Nodes per side, Generated Mesh
Goodies: Label elements, Label nodes, Modify mesh

Other Calculations

Properties File: Open Project..., Close Project, Main Menu, Solve, Quit
Enter/Edit Properties

Properties: x,y-thermal conductivity, r,z-thermal conductivity,Thickness,
   Heat Per Unit Volume, End Property Definition
Uniformity: by Element, by Input Region, by Entire Body
Windows: Whole Plot, Zone

Enter/Edit Boundary Conditions
B.C.: Nodal Boundary Conditions, End Boundary Condition Definition
Windows: Whole Plot, Zone

Solve File: Open Project..., Close Project, Main Menu, Solve, Quit
Solve Nodal Potential
Solve Potential Gradients
Other Calculations

Plot File: Open Project..., Close Project, Save Picture, Print Draft, Print Final,
   Main Menu, Library, Quit
PlotSize: Screen size, 8x10 page size

 Plot: Generated Mesh, Boundary Conditions, Nodal Potential, Element
   Potential, Nodal Potential Gradients, Element Potential Gradients, No Plot

Edit: Cut, Copy, Paste, Clear, Node Labels, Element Labels, BC 
   Labels, Nodal Potential Labels, Element Potential Labels, Nodal 
   Potential Gradient Labels, Element Potential Gradient Labels, Text 
   Labels, Select All, Refresh, Optimize

Goodies: Change Plot Specs, Zoom, Change value increments, Label 
   Nodes, Label Elements           (continues)
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Fonts: (user specific, including Chicago, Geneva, and Monaco)
FontSize: 9, 10, 12, 14, 18, 24, 36, 72
Style: Plain, Bold Italic, Underline, Outline, Shadow, Erase Background,

Align Left, Middle, Right, Digits

Library File: New Project..., Open Project..., Close Project, Duplicate Project..., 
   Print Draft, Print Final, Main Menu, Quit

Open File: New Project..., Open Project..., Close Project, Duplicate Project...,

   Print Draft, Print Final, Main Menu, Quit
Edit: Cut, Copy, Paste, Clear, File Attributes
Numbering: All numbers, Group numbers, Renumber
Set Attribs

 Program Organization

The main menu provides branching to all major modules of MP.   The menu list, with the
exception of the library which is used both first and last, indicates the typical progression
during problem solving.  The probable next module appears as the default when you create
the data files of the previous module.  Each module provides a linkage to the next and to the
immediately previous module.  If necessary, you can return to the main menu to branch to
other modules.

• Geometry  and Mesh  provide graphical tools for the automatic generation of the mesh and
for you to make detailed refinements in the mesh.  Automatic bandwidth reduction, a
technique to reduce storage requirements and computation time, is also available here.

• Properties provides the environment for you to enter the material properties and the
constraints.  You are responsible for defining a well-posed problem which has a unique
solution.

• In Solve you compute the desired output.  This module forms and solves the required
system of equations.

• In the Plot module you produce both diagnostic and publication quality, graphical output.

• In the Library module you have access to the numerical results.  This module also allows
you to create new projects and to duplicate existing projects.  You can also use this module to
formulate problems without utilizing MP’s graphical support.  You might choose to do this in
order to gain a deeper understanding of the internal numerical steps or to have greater
control over problem formulation.

MacPoisson commands are described in detail in this chapter in the normal sequence used
during problem solving.  This sequence also corresponds to the left-to-right ordering of the
menus on the menu bar.
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In this chapter a third, more complicated example is woven into the discussion.  The
illustrative figures correspond to a single heat conduction example—a bottom-heated flower
pot.  However, our primary goal is to present a definitive description of each command.  Each
command description is free-standing and does not depend intrinsically upon this particular
example.

Example: A Bottom-heated Flower Pot

Fig 3.1 A bottom-heated flower pot

We selected a contemporary problem for this heat conduction demo.  Figs 3.1 and 3.2 depict
an energy efficient alternative for promoting plant growth in a greenhouse.  Rather than
heating the entire greenhouse air (20°C), only the table on which the plant rests is heated
(30°C).  In this way the roots are warmed by the table rather than by the surrounding air.  
We are interested in determining the temperature profile of the potting material as
influenced by the insulation of the pot.  Later we shall also examine the effect of watering
the plant on the temperature profile.

The problem is axisymmetric—one of the two general classes of problems which you can
solve with MacPoisson.  The schematic (Fig 3.2) contains the details you need to analyze
this problem.  The meaning of the notes on the diagram become apparent as you complete
the following exercise.  Initially, let’s assume that the soil and pot have equivalent thermal
properties.  
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Fig 3.2 Inpit data for a bottom-heated flower pot

You wish to compute the temperature and temperature gradients within the pot.  You also
require plot and tabular output (Figs 3.3 & 3.4).

Fig 3.3 Plot output
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Fig 3.4 Tabular output

3.1 Main Menu.

Fig 3.5 Main menu
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Fig 3.6   menu from the main menu

The   Menu (Fig 3.6), a standard feature of Macintosh applications, is the first menu.

Fig 3.7  About MacPoisson...

About MacPoisson... (Fig 3.7) describes the application.  Included are the following: Title,
credits, version number, available RAM, serial number, copyright notice, licensing, and
ordering information.

Note: This program and documentation are not copy-protected, but are protected by federal
copyright laws and the license agreement; illegal transfer of this licensed intellectual property
will be regarded as an act of theft.
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Fig 3.8  About Project...

The About Project... (Fig 3.8) displays the project description, the problem type, and available
memory any time a project is active, i.e., open.

Keep a brief description of the problem here.  Use this as a scratch pad for reminders; make
changes at any time.

You selected one of the eight problem types in the Library module when you defined the
project; the type cannot be changed here.  Your choice of problem type influenced the
nomenclature used, the properties required, and the permissible boundary conditions.  Refer
to the Appendix  for a list of consistent units for each type of problem as well as a short list of
background resources.

Use this command to monitor memory utilization when you attempt to solve large problems,
especially when you successively refine the mesh to verify the solution.  Memory utilization
varies dynamically throughout the process.  Unneeded data structures are purged and new
data structures are created as needed.

Help #0.00
Fig 3.9 Help reference
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The Help # (Fig 3.9) varies throughout MP to serve as an online guide or index to the
appropriate help paragraph in Appendix A1.  The help message in the Appendix may also
cross-reference other portions of this manual.

Check Demo Mode (Fig 3.6) to suppress all file saving.  You can enter and leave Demo Mode
at any time as often as you wish; simply reselect Demo Mode to toggle.  The presence of the
check mark indicates that you are in demo mode.

Use Demo mode to explore tangential issues without fear of corrupting the data files which
are used in subsequent modules.  The file attribute system,  described in the Library module,
prevents the accidental use of incompatible data files.  For example, if you alter the
dimensions or properties files of a previously solved problem, all data files obtained using the
previous values are no longer compatible with the new data.   MP automatically disables such
files and will not load the files.  Your classroom presentations can be conducted in Demo
Mode without fearing that your lecture materials will vanish before your eyes!

Note: If you intentionally remain in Demo Mode while solving an original problem (rather
than giving a classroom demo), you will not be asked to save any data; therefore you cannot
continue with the next module which would require the nonexistent file.

Go to the Library module (Fig 3.95) to examine the status of the 18 files.  A black bullet in the
status column denotes active files; a blank denotes an inactive file.  An experienced user can
use the Set Attribs option in the Library module to change the attribute flags to recover files in
some instances.

The remaining entries in the  menu are desk accessories.  Refer to your Macintosh Utilities
User’s Guide for a description of the Font/DA Mover.

Fig 3.10  File Menu (Main)

Open Project... is enabled (not dimmed) only when no project is active.  Use the usual
Macintosh procedures to select your data disk drive and to navigate through the folders to
locate your project folder.  Select and open the folder.  Then select and open the project file.
Only one project can be open at any time.
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Fig 3.11a  Select a project folder and file

Fig 3.11b  Select a project folder and file

Note 1: When you create (define) a new project using the Library module, MP produces a
project folder and places a master file in the folder.  The master file (the workbook icon)
contains the data required to initialize and use the project’s 18 data files.

Close Project is enabled (not dimmed) only when a project is active.  Use Close Project if you
wish to open another project.  The Quit command automatically closes the open project.

Quit terminates your MP session and, if necessary, closes an open project.
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3.2 Geometry Module  

If you have not previously opened a project, do so now.  As you enter this module,
you must answer several preliminary questions.

Do you wish to create a new data file, completely ignoring all previous values?  Or do you
wish to be presented the previous data so you can make modifications or accept the old
values?

Fig 3.12  Use previous data?

The default coordinate axes type corresponds to the existing problem if you elected to modify
existing data.  Make that determination now, but you can change the type from the mesh
module.

Fig 3.13  Select coordinate axes type



Page 85

85

Fig 3.14  Assign axis endpoints

Word processor editing conventions apply here.  Use the tab key or mouse to change fields.
Press return or click OK to accept the data.

The Geometry tool palette and work area now appear along with a new set of pull-down
menus.

Fig 3.15   Menu (Geometry)

These commands are described in the Main menu section above.
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Fig 3.16  File Menu (Geometry)

Open Project..., Close Project, and Quit commands are described in the previous section on the
Main menu.  The remaining commands control branching.  Each module, including this one,
allows branching to the main menu, which allows you to then branch to any other module.
Branching to the next logical module in the formulation sequence, Mesh, is also provided.

Fig 3.17  Axes menu (Geometry)

Limits... and Type... allow you to revise your choice of axis endpoints and coordinate type.
You can change these limits at any time without destroying points outside the displayed range
to provide the equivalent of zooming.
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Fig 3.18 Geometry palatte

Fig 3.19 Examples of regions

In this module you define points (Fig 3.18) on the coordinate system which you subsequently
connect to form the curvilinear quadrilaterals used in the automatic mesh generation
algorithm of the next module.  Curvilinear quadrilateral “mesh generating regions”  (Fig 3.19)
include squares and rectangles with straight sides, as well as a generalization of these with
second degree polynomial sides.  You can form a triangular region as a degenerate case of a
rectangle with two consecutive sides forming a single straight line.

Tools to generate regions

Let’s review the uses of the tools on the palette (Fig 3.18); refer also to Fig 3.20.
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Fig 3.20 Use of tools

Use the point tool to create individual points.  Select either the mouse or the keyboard icon to
prescribe the input style.

 Point tool
With keyboard input (the default), enter the exact coordinates (Fig 3.21) and click OK.

Fig 3.21 Keyboard entry

If you choose mouse input, the cursor becomes a small square when placed within the range
of coordinate values, and the coordinates of the cursor are displayed at the bottom.  Position
the cursor and click.  You can press the option key to truncate the decimal portion of the
coordinates.
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 Deletion tool (selected)
Just beneath the point tool is the point deletion tool, which can be used with the mouse (the
default) or the keyboard.  With the mouse, position the cursor (a circle with an x) over a point
and click to remove the point.  To delete all points within a rectangular cluster (Fig 3.20),
select the points by dragging an enclosing rectangle and click within the selection rectangle.
Click outside the rectangle to deselect the points.  With the keyboard option, enter the exact
coordinates and click OK to delete a point.  Hint: The Move tool provides coordinate lookup
for points.  Note: MP ignores extraneous points during region definition.

 Line tool
Use the line tool to enter multiple points on a straight line.  With the keyboard (default)
mode, enter the starting point coordinates, press tab, enter ending point coordinates, and click
OK or press return.  MP draws a connecting line.

Click on the small numeric keypad icon to designate the number of interpolated points to be
spaced equally along the line.  To modify the number of intermediate points, reselect from the
numeric keypad on the screen.  If you wish to adjust the spacing of the points along the line,
simply drag the point along the line.  MP constrains movement to the line segment bounded
by the adjacent points.  The coordinates and the fraction of the distance along the line from
the starting point to the ending point are  displayed.  Click OK when you are satisfied with the
placement of the points.

The placement of these points has special significance.  Vertex points of the mesh generating
regions correspond to nodal points.  However, the intermediate points along the side of a
generating quadrilateral do not, in general, correspond to nodal points, but the placement of
these intermediate points does determine the spacing of the nodal points.  A point centered
on the side produces equally spaced nodes.  On the other hand, a point placed nearer one end
produces nodes spaced more closely at that end of the region.  You must place the
intermediate point between the first and third quartile point of the side for the algorithm to
produce satisfactory results.

Mouse implementation of this tool requires that you select the number of intermediate points
first and then visually place the starting and ending point.  To move points, use the move
point tool described below.
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 Arc tool
This tool generates points defined by circular and elliptical arcs.  The default keyboard entry
mode requests a center point for a circular arc, the starting point, and the number of degrees
counterclockwise.  Use the numeric keypad icon to set the number of intermediate points and
click OK to generate the points along a circular arc.

The mouse entry mode allows you to select a circular or elliptical arc and to designate
clockwise or counterclockwise entry and the coordinates of the center point.  Designate the
number of intermediate points with the numeric keypad icon before drawing the arc.  Then
click the circles on the coordinate axes icon  to select 90, 180, 270 or 360 degrees quickly.

Using the mouse, place the cursor at the center point and drag to establish the “radius”.  The
“radius” will be the semi-major and semi-minor axes of the elliptic arc.

Move point tool

Place the loop cursor over a point and click to select it.  Then enter the coordinates of the
change point.

Note: In axisymmetric problems, to minimize errors, one side of each element should be
parallel to the axis of symmetry.  See Chapter 4 for the computational details.
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 Region definition tool
After you define the individual points, click the region definition tool.  Use the loop cursor to
locate the points.  Begin at a vertex point and click.  Continue in counterclockwise order until
you have designated all eight points.  If you make a mistake, reselect the region icon to undo
and begin again.  Press the shift key to change the cursor symbol from a circle to a small square
(Fig 3.21).

Fig 3.21 Region definition

A different fill pattern identifies each of the multiple generating regions (Fig 3.22).
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Fig 3.22a Defining multiple regions

Fig 3.22b Defining multiple regions

One or more sides of a generating region can be a second degree polynomial (Fig 3.23).  In this
instance, we split a five-sided region to form two four-sided regions.
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Fig 3.23 Regions with curvilinear sides

 Delete region tool

Select this tool and then click within a region to remove the defining boundaries.  To undo,
i.e., redefine the region, click the delete region tool again before any other operation.

When you have defined all regions,

• Select Mesh from the File menu, and

you will be asked to save the data.

Fig 3.24  Save data dialog
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Unless you are in Demo mode, you must save the data before you leave a module (Fig 3.24).
You can save data in Binary Format (i.e., untranslated) for greatest speed, or in the standard
Text Format which can be read by a word processor.  In fact, you can formulate a problem
without the graphics tools by using a word processor.  You can translate file types using the
Library module.

If you save the data, as you must if you intend to use the data in subsequent modules, MP
disables all existing dependent files.  Click NO if you do not wish to save the data.  Click
Cancel if you wish to return to the Geometry module without saving the data.

3.3 MESH Module.   

Use this module to generate the mesh of elements, to save nodal coordinates and mesh
connectivity data, to renumber the nodes to improve computation efficiency, and to identify
the boundaries.  MP uses the file (.Geom) from the previous module.  Three files (.Mesh,
.RMesh, and L/B) are created by this module.

The  menu (Fig 3.25) contains the commands already described for the Geometry module.
The help number, of course, has changed.

Fig 3.25 Mesh menus

Open Project... and Close Project were also described in Geometry.  Main Menu sends you to
the Main Menu; Properties is the normal exit path and Quit allows you to terminate the
session.

The mesh module handles two major tasks: 1) generating and refining a mesh and
2) renumbering the mesh for improved computational performance.
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Fig 3.26 Mesh module

3.3.1 Generate Mesh.

• Click Generate Mesh (Fig 3.26).

The following menu commands (Fig 3.27) become available:

The Help number has changed to reflect the new situation.  Otherwise the  menu is as
described earlier.

Fig 3.27a Nodes menus

The File menu is dimmed, indicating that it has been disabled.

The Generate Menu and the Generate button activate mesh generation after you specify the
number of nodes you want to place along each side of a mesh generating region.
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Fig 3.27b Nodes menus

Use the Windows menu to bring the desired window to the front.

Fig 3.27c Nodes menus

Use the Goodies menu to label elements and nodes and modify the mesh.

Fig 3.27d Nodes menus

Detailed instructions follow.

Let’s now define the mesh.
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Fig 3.28 Nodes per side palette

To specify the number of nodes along the side of a region (Fig 3.28), you first

• Select a side by clicking in the small rectangle on that side.

If you have generated the regions properly, the opposite side of the region is automatically
selected by the program.  If you have defined multiple regions, commonly constrained sides
are also identified by the program.

To specify the number of element vertices along the selected side(s),

• Click the desired number in the numeric keypad at the top left of the window.

• Repeat the process for each side.

After you have assigned a value to each side, MP displays the number of variables to be
computed, i.e., the number of degrees of freedom or DOF, below the keypad.  For this scalar
potential problem, one unknown is associated with each element node.  Also, the DOF is
equal to the number of equations to be solved.

Labels:

• Select Label elements or Label nodes from the menu to identify the node and element
numbers.
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• Reselect the command to remove the numbering (and the check mark before the
command), or,

If the element or node numbers are too close to read, enlarge that portion or zone of the mesh
as follows:

• Press the option key and the cursor changes to a plus sign.

• Identify the area to be enlarged by dragging a rectangle with the mouse (Fig 3.29).

Fig 3.29 Define a zoom rectangle
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Fig 3.30 Enlarged view

• Option-click (i.e., press and hold the option key and click) in the rectangle (Fig 3.29) to
redraw the area as large as the screen size permits (Fig 3.30).

• Select the Generated mesh window (Fig 3.27) using the Windows menu (or Click the close
box on the zone window).

Modify:

We described two techniques for specifying mesh refinement: 1) move the middle point
between two vertices on the side of a mesh generating region nearer one end of the side to
make the elements smaller at that end, and 2) specify the number of nodes on each side of the
mesh generating regions.

Since you must specify the potential boundary conditions at nodal points, place nodes such
that:

• elements are smaller in regions of greatest change;

• elements are roughly equilaterial; and

• element sides coincide with geometric boundaries, material property changes, and sources.

NOTE: Nodal placement must anticipate these requirements.

Three additional graphical techniques are provided in this module to accommodate these
requirements.
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Reverse elements:

Fig 3.31 Reverse elements

• Select (the default) Reverse elements (Fig 3.31).  Then,

• Click in two adjacent elements.  Next,

• Click Redefine to reverse the common boundary (Fig 3.32).

          
Fig 3.32 Before, during, and after redefine

• Click OK after you have completed all modifications of the three types.

Move nodes:
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Fig 3.33 Move nodes

• Click Move nodes (Fig 3.33).

• Click on a node to select it (Fig 3.34).

         
Fig 3.34 Before, during, and after move node

The node and element sides connecting to that node are highlighted and the coordinates
displayed (Fig 3.35).

Either  (Fig 3.35)

• Assign the exact coordinates via keyboard, or

• Click in a triangle on either side of the Home button (left, right, above, or below) within the
diamond to move the point.
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• Continuously press the mouse button to make repeated steps.  If you wish,

• Click on Home to return to the original location.

• Click OK after you have completed all modifications of the three types—redefine, move and
add.

Fig 3.35 Node movement
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Add nodes:

Fig 3.36 Add nodes

• Click Add node (Fig 3.36).

• Click on two nodes of any element (Fig 3.37), and then

• Click on Add to bisect that side of the element.

     
Fig 3.37 Before, during, and after add nodes

Two elements having a common side become four elements.  If the side connecting the nodes
is a boundary, MP creates  only one additional element.  Note: No undo command exists for
this operation; you must regenerate the mesh to begin again.

When you are satisfied with the mesh (i.e., after you have completed all modifications of the
three types—redefine, move, and add),
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• Click OK.  Then

• Select End Generation from the Generate menu (Fig 3.27) to return to the Mesh menu.

If you are not  in Demo mode, MP asks you to save the Mesh data (Fig 3.38).

Fig 3.38 Save mesh data

Either:

• Click No to abandon the data and return to the Mesh module menu
or
• Click Cancel to abandon the data and return for another attempt at mesh generation
or
If need to use this data in subsequent steps,

• Select either Binary Format for faster performance or Text Format if you need to examine
the file with a word processor.

• Click Yes (Fig 3.38).

Note: This also disables all data files which might now be incompatible.  Experienced users
can use the techniques described in the Library module to over-ride this status (§3.7.1).

3.3.2 Other Calculations.

Click Other Calculations (Fig 3.26) to access node renumbering and calculations to speed
subsequent graphics calculations.
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Fig 3.39 Bandwidth reduction choices

Normally you select bandwidth reduction, especially if you have used multiple mesh
generating regions.  However, if you have manually created a file with a desired numbering
scheme, you may wish to prevent automatic renumbering.

If you choose bandwidth reduction you can observe the progress of the reduction process.  The
display traces the steps in the renumbering process.  If bandwidth reduction was not possible,
the original numbering is preserved.

Either:

• Choose Cancel (Fig 3.39) to abandon the process,
or
• Choose Continue to proceed with the bandwidth reduction.

If you are not  in Demo mode, MP asks you to save the Renumbered data (Fig 3.40).

Fig 3.40 Save renumbered data

Either:

• Click No or Cancel to abandon the data and resume with unique lines,
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or

If you need this data in subsequent steps,

• Select either Binary Format for faster performance or Text Format if you need to examine
the file with a word processor.  Then,

• Click Yes.  This also disables all data files which might be incompatible.

The next step is the automatic identification of unique plot lines and the boundary lines.  This
reduces the plotting time and finds lines to be presented during the subsequent boundary
condition assignment process.

If you are not in Demo mode, MP asks you to save the line information (Fig 3.41).

Fig 3.41 Save line information?

Either:

• Click No or Cancel to abandon the data and return to the Mesh module menu.

If you need this data in subsequent steps,

• Select either Binary Format for faster performance or Text Format if you need to examine
the file with a word processor.  Then,

• Click Yes.  This also disables all data files which might be incompatible.

When you have completed the mesh calculations,

• Select >>Properties from the mesh module screen (Fig 3.26) or from the File menu (Fig 3.25).
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3.4 PROPERTIES Module. 

After you have prepared the mesh files using the Mesh Module (or without graphics support
using the Library module), enter the Properties module to define the material properties and
to assign the boundary conditions.  These steps are required to uniquely define a problem and
to create the properties file (.Prop), the initial (or input) boundary conditions (.IBC), and final
(or equivalent nodal values) boundary conditions (.FBC).  This is the final step in problem
formulation.

The  menu (Fig 3.42) contains the commands described in the Geometry module.  The help
number, of course, has changed.

   
Fig 3.42 Solve menus

The Open Project... and Close Project are also described in Geometry.  Main Menu sends you
to the Main Menu; Solve is the normal exit path and Quit allows you to terminate the session
and automatically close the project.

This module handles two major tasks: 1) entering and editing element properties (including
distributed sources) and 2) entering and editing boundary conditions or constraints (on
boundaries and at interior nodes).  You enter distributed source and sink conditions here
because the input structure is the same.

You can enter properties and boundary conditions (Fig 3.43) in either order because MP does
not combine the results until you leave this module.  Note: The specific sequence for applying
convection conditions is automatically observed by MP.

Let’s discuss properties first.
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Fig 3.43 Properties module

3.4.1 Properties.

If you have not selected a project when you reach the Properties module screen, follow the
usual steps to open a project file.  If you have not previously created data files for this module,
the Properties and Boundary Conditions buttons will read “Enter”, rather than “Edit”.

• Click Enter (or Edit) Properties.

If a project is already open and a properties file already exists, you can either create a
completely new data file or edit the existing data.  If only minor variations are needed, the
latter approach is quicker; then

• Click Edit.

Fig 3.44 Previous data exists
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A tool palette, a work area, and new menus appear.

The  menu contains previously described commands; see the Geometry module.  The help
number, of course, has changed.

Fig 3.45 Properties menu

The file menu is unavailable until you return to the Properties module screen (Fig 3.43).

The properties menu varies with the particular application of Poisson’s equation as indicated
below.  If the properties  in the x and y (or r and z) directions are the same, press the command
key (cloverleaf) while selecting the second property from the properties menu to copy the
values for an isotropic body.

The uniformity menu allows you to enter common properties for the largest possible unit.

The windows menu provides movement between the whole plot and a zone plot, which can
be created as described below.  We now describe each of these menu commands.
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Fig 3.46  The properties palette

The properties palette (Fig 3.46) provides visual assignment of properties.

• Select the property type from the properties menu (Fig 3.45).

The property selected is named in the title bar of the window.  The default is the first listed
property.

• Click slightly to the right of one of the 14 shaded squares, and a blinking cursor appears.
Using a consistent set of units (See Chapter 4),

• Enter the value you wish to associate with this pattern.

• Click on the shaded square to the left of your entry to select this value.

A small square around the pattern identifies your choice.

The properties listed on the menu can vary from element to element, vary only by mesh
generating region, or be uniform throughout the problem.  Use the Uniformity menu to set
the largest unit of uniformity.  If you select “by Element”, MP creates the required data
structures.  If the properties are uniform except for a few elements, first select “by Entire Body”
(Fig 3.45) to make the global assignment and then use “by Element” to revise the exceptions.

• Click on elements (or regions or the entire body) to assign this value.
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The number of the selected element is displayed at the bottom of the screen.  If you wish to
shade multiple contiguous elements, simply drag the cursor with the mouse button pressed
(Fig 3.46).

If you require an enlarged view to satisfactorily assign the properties,

• Press the option key while dragging to create a selection rectangle.

• With the option key still pressed, click within the selection rectangle.

After assigning values,

• Select Whole Plot from the Windows menu (Fig 3.45).

CAUTION: Do not assign meaningless values, e.g., zero thickness or conductivity, to
elements.  The thickness value does not appear if the problem has axial symmetry.

• Select the other properties from Properties menu and enter values.

Hint: If the problem is isotropic, i.e., properties are the same along both coordinate axes, press
and hold the command (clover leaf) key when selecting the other component from the
Properties menu to copy the values to the other coordinate direction.

Note: Enter distributed sources (Fig 3.45) in this submodule; enter line sources in the
boundary conditions submodule.

• Revise your property assignments if necessary, then

• Select End Property Definition from the Properties menu (Fig 3.45) to return to the
properties module screen (Fig 3.43).

If you are not  in Demo mode, MP asks you to save the properties data.

Fig 3.47 Save properties data

Either:
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• Click No or Cancel to abandon the data and return to the properties module menu (Fig 3.43),
or

If you need this data in subsequent steps,

• Select either Binary Format for faster performance or Text Format if you need to examine
the file with a word processor, and

• Click Yes.   Note:  This also disables all data files which now might become incompatible.

MP returns you to the Properties module screen (Fig 3.43).

3.4.2 Boundary Conditions.

If you have not selected a project, the Open Project button is enabled on the Properties module
screen (Fig 3.43).  You must follow the usual steps to open a project file.  If you have not
previously created data files for this module, the Properties and Boundary Conditions buttons
will read “Enter”, rather than “Edit”.

• Click Enter (or Edit) Boundary Conditions.

If a project is already open and boundary condition files (initial and nodal equivalents) already
exist, you can either (Fig 3.48) create a completely new data file or edit the existing data.  If only
minor variations are needed, the latter approach is quicker.

• Select Edit (Fig 3.43).

Fig 3.48 Edit existing data

A tool palette and new menus appear.  In this module you assign constraints —boundary
conditions and internal nodal conditions—which the solution must satisfy.  The problem
must be “well-posed”, i.e., lead to a unique solution.  The responsibility for creating a well-
posed problem rests with the user.  An improperly formulated problem can lead to an ill-
conditioned system of linear algebraic equations.  Access to the data files in the Library
module permits you to explore the numerical details.
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The  menu (Fig 3.49) contains previously described commands; see the Geometry module.
The help number, of course, has changed.

Fig 3.49 Boundary conditions menu

The palette for the visual input of boundary conditions is immediately available when you
enter this submodule.  After you have assigned the boundary conditions, by selecting Nodal
Boundary Conditions  you can display the internally generated nodal equivalent conditions
which will be used in subsequent calculations .  Use End Boundary Conditions to leave this
module; the File menu is unavailable until you end boundary condition input.

Note: Recall that the strategy used in MP is to formulate a system of equations to find the
dependent value at the nodal points.  Consequently, MP converts the input constraints into
“nodal equivalents”.

The windows menu provides movement between the whole plot and a zone plot.  See Fig
3.51 for details required to create a zone plot.

These menu commands are described in detail below.

Assign the constraints.

As indicated in the discussion of the properties submodule, you can apply three (or four) types
of constraints.  The first and second (line sources and potentials) are applied at nodes, and the
second and third (flux and convection) apply to the face of an element (and are applied at the
midpoint between two nodes, but are internally converted to equivalent nodal values.  In all
instances you must use a consistent set of units! (Refer to Chapter 4.)
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Fig 3.50 Boundary condition tools

                   
 nodal sources

You can specify line sources at nodes for two-dimensional problems and ring sources for
axisymmetric problems.  You must supply the signed value of the source per unit length (or
negative values for a sink) before you assign the icon to appropriate nodal points.

                    
 nodal potential
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You can specify the potential at nodes on the boundary or in the interior.  You must supply
the numerical value before you assign the condition to the nodes .

                  
 flux along the surface of any element on the boundary

You can specify the (signed) flux (i.e., not the potential gradient, but the conductivity times the
gradient) on the face of any element.  Assign the icon at the mid-side point of the edge of the
element.  Select the flux component (x or r direction, y or z direction, or normal) before
entering the numerical value.

                  
 surface convection— a linear combination of potential and gradient

You can apply the linearized convection condition on the face of an element in heat
conduction problems.  You must supply the surface coefficient (s.c.) and the temperature of
the surrounding fluid (fluid temperature, or f.t. ).  Click on the mid-side marker of the
element.  See Chapter 4 for the mathematical details and Chapter 5 for illustrative examples.

 erase a constraint

Use this tool in combination with the above four tools.  MP erases ONLY  boundary
conditions of the exact type selected.  This is especially useful when multiple types of
condition appear at the same node, such as at a corner.
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The properties and boundary condition menu vary according to the specific problem type:

Type Potential Conductivity 1 Source 2 Bdy Cond3

General Potential Conductivity Source
Heat Temperature Conductivity Heat
Torsion Stress Function Shear modulus Twist/length
Electrostatic Electrostatic Pot. Permittivity Charge
Fluid Flow Velocity Pot. Mass
Magnetostatic Magnetostatic Pot. Permeability
Seepage Piezometric Pot. Permeability Source
Gravitational Grav.Pot. Mass

1 You can specify conductivity differently for each axis direction for both Cartesian and Axisymmetric directions.
You can specify the length (i.e., thickness) of each element for Cartesian coordinates.

2 Enter the distributed source on a unit volume basis. For a torsion problem the analogous input is angle of twist per
unit length.

3 Boundary conditions applied at nodal points include source and potential; conditions applied at element midside
are flux and convection.

To assign the same constraint value over a range of the boundary, keep the shift key pressed
continuously as you select first the beginning point of the range and then counterclockwise
around the boundary to the ending point.  A circle icon appears at the top left of the work area
to indicate you are applying the range condition.

Note: Your choice of beginning and ending point determines the designated segment.  If you
make the wrong choice and select the complement, use the eraser tool.

If you need increased resolution to unambiguously assign the constraints,

• Press and hold the option key to turn the cursor into a plus sign and drag a selection
rectangle (Fig 3.51).  With the option key continuously pressed, click inside the selection
rectangle to produce an enlarged view.
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Fig 3.51 Zoom to assign conditions
After assigning the constraints

• Select Whole Plot from the Windows menu to return to the composite view.

Note: To review boundary condition assignments: If you have selected the nodal source or
potential icon, place the cursor over a node; if you have selected the flux or convection icon,
place the cursor over an element side marker.

After you have assigned all conditions,

• Select End Boundary Condition Definition from the B.C. menu (Fig 3.49).

If you are not  in Demo mode, MP asks you to save the boundary conditions (Fig 3.52).

Fig 3.52 Save boundary conditions?
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Either:

• Click No or Cancel to abandon the data and return to the properties module menu (Fig 3.43),
or,

If you need this data in subsequent steps,

• Select either Binary Format for faster performance or Text Format if you need to examine
the file with a word processor.  Then,

• Click Yes.  This also disables all data files which might be incompatible.

If you need make no further changes to properties or boundary conditions,

• Select >>Solve from the properties module screen (Fig 3.43) or from the File menu (Fig 3.42)
to move to the next module.  You have just completed the formulation process.

3.5  SOLVE Module.     

This module uses the data files which describe the mesh (.RMesh), the properties (.Prop), and
the boundary conditions (.FBC) to form a system of simultaneous linear algebraic equations
and then to solve for the nodal values, average element values, and nodal and element
gradients.

Normally you save only the nodal values (.NPot) but intermediate results can be saved for
tutorial purposes, if desired.  MP first uses the geometry and properties files to create by
superposition of element values a global system of equations (source vector .IV and stiffness
matrix .IS) in matrix form. Next these global equations are modified to satisfy the constraints.
If you have assigned any convection conditions (in heat conduction problems), MP applies
them to the “stiffness” matrix first and stores them (.CC. file).  Then MP applies the remaining
constraints, converted earlier to nodal equivalent conditions, to the source vector and
“stiffness” matrix (and stores them as .MV and .MS, respectively).

Enter Solve from the Properties menu (Fig 3.43) or double-click Solve from the main menu
(Fig 3.5).  If no project is open, you must open one.

The About MacPoisson..., About Project..., Help, and Demo Mode commands (Fig 3.53) were
described for the geometry module and are the same here, except the help number has
changed.
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Fig 3.53 Solve menus

Similarly, Open Project..., Close Project..., and Quit have been described already.  Plot is the
next logical module when solve has been completed.

The solve module (Fig 3.54) computes: nodal potentials, average element potentials, and
nodal and element gradients, and miscellaneous calculations.  You need not calculate all three
groups, but if computed, the top-to-bottom order must be followed.

@ @ @ @ @ @

Fig 3.54  Solve Module

The solve module (Fig 3.54) computes: nodal potentials, average element potentials, and
nodal and element gradients, and miscellaneous calculations.  You need not calculate all three
groups, but if computed, the top-to-bottom order must be followed.

3.5.1 Nodal Potentials.
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• Click Solve Nodal Potentials (Fig 3.54).

MP forms the system of equations, modifies them to reflect the boundary conditions, solves
them by Gaussian elimination, and stores the nodal results (.NPot).

If you do not wish to examine the intermediate files (.IV, .IS, .CC, .MV, .MS) or do not have
sufficient disk space, do not save the intermediate vectors and matrices.

• Click No (Fig 3.55).

Fig 3.55 Save intermediate files?

You can interrupt computations at any time by clicking the Abort button, which changes in
name to OK (Fig 3.56) when MP completes the calculations.  The speed of these calculations is
dependent upon available RAM.  Significantly more disk activity is required for a 512KE
Macintosh than for more recent Macintoshes with more memory.  The Macintosh II is
noticeably faster than an SE; the MP version which utilizes the 68881 math coprocessor
(standard with the Macintosh II) is dramatically faster, perhaps by a factor of 25 to 30.  MP
provides progress markers and time estimates for the Macintosh being used.
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Fig 3.56 Nodal potential calculations

• Click OK (Fig 3.56) to return to the solve module screen (Fig 3.54).

After MP computes the nodal potentials, you can, if desired, calculate the average element
temperatures, the element potential gradients and the nodal potential gradients.  MP uses the
consistent element method of smoothing (Segerlind, 1984).

3.5.2 Potential Gradients.

If desired,

• Click Solve Temp. (Potential) Gradients (Fig 3.54).
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Fig 3.57 Gradient calculations

You can interrupt the computations at any time by clicking the Abort button (Fig 3.57).

• Click OK (alias the Abort button in Fig 3.57) to return to the module menu.

3.5.3 Other Calculations.

If desired,

•  Select Other Calculations (Fig 3.54) for the infrequently needed resultant (or equivalent
sources) and resultant surface fluxes.

You can interrupt computations at any time by clicking the Abort button (Fig 3.58).  MP
reports the elapsed time.

• Click OK (alias the Abort button in Fig 3.58) to return to the solve module menu.

Note: Regardless of Demo Mode status, MP saves the computed files.
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Fig 3.58 Other calculations progress indicator

When ready to resume,

• Click >>Plot on the solve module menu (Fig 3.54) or select Plot from the File menu (Fig
3.53).

3.6 PLOT Module. 

Note: To enter Plot, either click the >>Plot button on the Solve module screen (Fig 3.54) or
double-click Plot on the main menu (Fig 3.5).  If you have not opened a project, you must
choose Open Project... from the the File pull-down menu (Fig 3.59).

This module uses the data files created in the previous modules to graphically portray the
project and to present the results.  Two classes of graphics are possible: screen-sized diagnostic
plots and 8 by 10 inch publication quality plots with extensive labeling.  Plots include:
Generated Mesh, Boundary Conditions, Nodal Potential, Element Potential, Nodal Potential
Gradients, and Element Potential Gradients.  In the next section (Library module) we provide
tabular output.
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The  menu (Fig 3.59) provides the usual information about MacPoisson and the project.
The help number identifies the context-sensitive help message from the appendix.  You can
select and unselect demo mode at any stage.  However, Plot creates picture files, but no data
files, and, therefore, cannot corrupt the data files as long as you remain in this module.  Demo
mode does not affect file saving in this module.

Fig 3.59 Plot menus, Part 1

The File menu provides the usual capabilities to open and close a project, to branch to the
Main menu or to the next logical module, and to quit.  In addition, you can print 8x10 plots on
an ImageWriter or a LaserWriter.  Note: Use Chooser on the  menu to select the print
driver.

You can send copies of the screen sized plots to the ImageWriter using caps-lock command
shift 4 or save  them to disk using caps-lock command shift 3.  For a LaserWriter screen dump
you must have an additional desk accessory or first save the screen as a MacPaint file using
command-shift-3.

You can print the 8x10 page size plots on the ImageWriter or the LaserWriter using the print
commands on the File menu.  Using MacPaint or a program having similar capabilities you
can print later plots saved using the Save Picture... command.

The PlotSize menu defaults to the smaller and more quickly drawn Screen size plots (Fig 3.60).
It does not save space for a tool palette, and the edit and label pull-down menus provide node
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and element numbering, zoom capability, and control for the numbering format. MP
provides automatic value lookup for node, element, and potential values.

Fig 3.60 Screen plots with lookup

The larger plots (Fig 3.61) correspond to the maximum size printable with an ImageWriter.
MP provides the usual cut, copy, paste, clear, and select all commands.  In addition it provides
font, font size, and style selection, as well as left, middle and right justify and background
control.  LaserWriter quality labels are available for nodes, elements, boundary conditions,
nodal potentials,  element average potentials, nodal potential gradients, element potential
gradients, and free-form text labels.



Page 126

126

Fig 3.61 Larger 8x10 plots with rapid scrolling and labeling

You can produce six different plot types in either of the two sizes.  The plots of problem
formulation are generated mesh and boundary conditions; and the output results include
contour plots of nodal potential, shaded plots to depict average element potential, contour
plots of nodal potential gradients, and shaded plots of components of element potential
gradients.

Depending on the plots, you can elect to superimpose the mesh or not, display only the
boundary, label some or all nodes and elements, choose the vector components of gradient,
choose the contour line values, set the format of displayed values, and automatically locate
some or all labels and prescribe various display features.  MP automatically retrieves the
relevant data files as needed.
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3.6.1 Screen Size Plots.

First, let’s examine a set of screen size plots.

Generated Mesh

Fig 3.62 shows a mesh with numbered nodes.  To produce this figure,

Fig 3.62 Node numbers

• Select Generated Mesh from the Plot menu (Fig 3.59).

• Select Label Nodes from the Goodies menu (Fig 3.63)
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Fig 3.63 Plot menus, Part 2

• Reselect Label Nodes to remove the labels.

If desired,

• Select Element Numbers from the Goodies menu.

• Reselect Element Numbers to remove them.

Use the zoom option of the Goodies menu for a clearer view of the bottom corner.

• Select Zoom (Fig 3.63) on the Goodies menu.
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Fig 3.64 Zoom

• Create a selection rectangle (Fig 3.64) by dragging with the mouse.
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Fig 3.65 Enlarged plot

• Click OK (Fig 3.64) to generate the enlargement (Fig 3.65).

• Select No Plot (or Generated Mesh again) from the Plot menu (Fig 3.59) to resume.

MP also provides an alternative zoom.  Again,

• Select Generated Mesh from the Plot menu.,

and

• Select Zoom from the Goodies menu.

Then

• Select Multiple (Fig 3.66) and, if desired, adjust the number of subdivisions along each
dimension.  This technique creates multiple zones which MP draws to the same scale and you
can assemble to form a large mosaic.
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Fig 3.66 Multiple plot

• Click in the rectangle of greatest interest and click OK.

• Select zoom again.  The previously drawn zone will be shaded.

• Click in another zone and then click OK.

Boundary Conditions

Next plot the boundary conditions.

• Select Boundary Conditions from Plot (Fig 3.59).

You can plot the boundary conditions as entered as well as the computed nodal equivalent
values (Fig 3.67).
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Fig 3.67 Boundary conditions type

Note: The Labels option is available only for 8x10 plots.  However, display only labels are
provided for diagnostic plots.

• Select Input and click OK.

After MP has drawn the figure and completed the cursor count-down (while data structures
are being created),

• Position the cursor over each boundary condition and press to echo the boundary condition
type and numerical value.

To improve readability of the numerical values,

• Select Digits from the Style menu (Fig 3.77) to set the display format (Fig 3.68).
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Fig 3.68 Number format

Fig 3.69 Boundary conditions

• Click Fixed, and

• Scroll to Rounding Position of 1.

• Click OK.
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Now redisplay selected boundary condition values (Fig 3.69).

If desired,

• Select Boundary Conditions from the Plot menu again (Fig 3.59).

• Choose Nodal Boundary Conditions (Fig 3.67) to produce the second plot in Fig 3.69.

Nodal Potential

• Select Nodal Potential from the Plot menu.

Fig 3.70 Superimpose mesh

If you do not wish to superimpose the mesh on the lines of constant potential, leave that item
unchecked (Fig 3.70).  The Labels option does not apply to these smaller diagnostic plots.

Next you prescribe values for the contour plots (3.71).
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Fig 3.71a Specify contour values

Fig 3.71b Specify contour values

Usually you choose rounded values.
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• Click Digits (Fig 3.71) and set Fixed and the Rounding Position to 1.

• Click OK.

• Round down the minimum plot value to 23.0 (Fig 3.71).

The choice of minimum, maximum, increment size, and number of increments involves an
interdependency; you choose any three and click on the button adjacent to the remaining
quantity to find the fourth value.  MP disables the OK button if the current settings do not
correspond to a compatible set of values.

• Set Increment to 0.5 and click on <<Calc opposite Increments scroll bar to calculate that
value.

Now that you have a consistent set of choices MP enables the OK button.

• Click OK.

• After the cursor count-down finishes, press on any contour to display the value (Fig 3.72).
Even if a contour consists of multiple parts, MP highlights the selected contour.

Fig 3.72 Lookup selected contour
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Element Potential

This option produces a shaded plot of the average element temperature.

• Decide whether to include a mesh overlay (Fig 3.73) and click OK.

Fig 3.73 Element temperature

• Assign data ranges for the plot, as described above for nodal temperature.
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Fig 3.74a Average element temperature with mesh overlay

Fig 3.74b Average element temperature without the mesh overlay

• Press the cursor on an element for the auto-lookup feature (Fig 3.74).
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• If desired, use the Digits option to set the display format.

Nodal Potential Gradients

• Select Nodal Potential Gradients from Plot menu.

• Designate the component you want to plot (Fig 3.75).

Fig 3.75 Select gradient plot type

• Designate whether you want the mesh displayed.

• Click OK.

• Supply a compatible set of rounded plot values. See Nodal Potential plot for details.

• After MP generates the plot (Fig 3.76), place the cursor on a contour and press to display the
contour value.
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Fig 3.76a Nodal resultant gradients

Fig 3.76b Element resultant gradients

The corresponding element gradients appear on the right in Fig 3.76. MP provides element
number and element gradient lookup.
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3.6.2 Presentation Plots

• Select the 8x10 PageSize to produce presentation quality plots.

You can produce in publication quality size each of the six plot types described above.  Also,
the remaining plot menus which deal with labels apply here (Fig 3.77).  The Font and
FontSize menus reflect the fonts in your system file.  Note: Use the Font/DA Mover to
change the list.

Fig 3.77 Plot menus-3

The first six entries of the Style menu correspond to their use in word processors.  Erase
Background specifies whether the background for a label is erased.  The next three options
determine whether the labels are left, middle, or right justified within their fields.

The last (Digits...) has been demonstrated already (Fig 3.68), but we described it below too.

After you have selected items in the Style menu, all subsequent labels will be affected until
changed. You can change any or all previously entered labels if you first choose Select All
from the Edit menu or shift-click to select any subset of labels.
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Fig 3.78 Large plot with contour labels

Labeling capabilities allow you to label some or all of the elements, nodes, boundary
conditions, and contour values.  You can move labels and select the font, font size, and
display style of the labels.  The label can be made opaque or transparent and can be left,
center, or right justified within its field.

After you select the combination of features required in your plot, MP creates only the
required data structures.  A progress indicator (Fig 3.79) reports the steps in this process.
The image MP creates is larger than the standard Mac SE screen and is slightly larger
than the Mac II standard screen so MP generates the plot off-screen.
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Fig 3.79 Progress indicator

Figures 3.80 through 3.84 illustrate these capabilities.

The generated mesh (Fig 3.80) was saved as a MacPaint™ picture, pasted into this
document and reduced to 50% of the original size.  All node and element numbers were
placed using the defaults.  The plot need not contain all labels of a given class.  You select
the font, font size, and style.  You control alignment within the print field and whether the
label overwrites or masks the figure.  The labels can be repositioned for clarity and
aesthetic purposes, even if the erase background feature has been used.
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Fig 3.80 Node and element numbering
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The boundary condition (Fig 3.81) plot also provides automatic lookup of values.  In this plot
some labels have been removed and others repositioned for improved clarity.  Somewhat
higher resolution can be obtained by printing directly from within MP since the object-
oriented graphics need not be converted into the lower resolution  bitmapped form.

Fig 3.82 illustrates the contour plot capability of MP.  You specify which contour lines are
plotted.  Up to 20 such lines can be created automatically by interpolation of the nodal
potential values.  You specify the format of the contour labels.  The labels can be
repositioned.  This figure also illustrates the use of free-form text labels.

The average element potential can also be represented using up to 16 different shading
patterns (Fig 3.83).  Automatic lookup of element number and element average potential is
available..

Fig 3.84 displays lines of equal resultant gradient (i.e., magnitude of the vector sum of the r
and z components of the potential gradient).
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Fig 3.81 Boundary conditions
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Fig 3.82 Constant temperature lines
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Fig 3.83 Average element temperature
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Fig 3.84 Constant gradient lines
Note: This is not the family of stream lines orthogonal to the constant potential lines.
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Details of plot preparation

Fig 3.85 Plot palette

The standard screens can display only a portion of the larger plots (Fig 3.85); therefore, MP
provides scroll bars for horizontal and vertical movement.  In addition, the miniature
portrait window  at the top left corner provides rapid scrolling, including diagonal
movement.  Drag the inversed rectangle, which corresponds to the visible portion of the plot
at the right, to a new location and release.  Click the box in the bottom right corner to center
the figure.

Just below the miniature portrait are the icons for adding, deleting, and moving labels of
the type selected from the Edit menu.  MP provides eight label types (Fig 3.86a,b).

• Select either node, element, boundary condition, nodal potential, element potential, nodal
potential gradient, element potential gradient, or text label.

You must select the leftmost icon of Fig 3.85 when you wish to add a label,  The second icon
displays an X and is active only when you have selected a label by shift-clicking.  Click the
third icon to drag a label.

Note: If you have selected the third icon and subsequently wish to add a label, you must first
reselect the add icon!

Note: Shift-click to select labels before making any changes in font, font size, style, etc.
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Fig 3.86a Plot specification menus

Fig 3.86a Plot specification menus

Fig 3.86b Plot specification menus
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Fig 3.86c Plot specification menus

Fig 3.86d Plot specification menus
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Fig 3.86e Plot specification menus

Cut, copy, paste, and clear on the Edit menu work as you would expect.

Note: These options are enabled only if you elected to create the requisite data structures—
either before you created the figure or from the Goodies menu later—and only for the
relevant plot type.

Note: You must select the ADD icon, not the MOVE icon, when you wish to add labels.
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Fig 3.87 Modify labels

If you chose selected nodes, elements, or contours, click on the location of the desired label
and MP automatically looks up and places the correct value on the plot. Use shift-click to
select one or more labels (Fig 3.87).  While selected, the font, font size, and style menu
selections can be changed.

Use Select All to select all of the currently selected class of labels (on the Edit menu—Fig
3.88)  for modification, e.g., change of font or font size.  Shift-click to remove objects from the
set of selected objects.
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Fig 3.88 Edit menu

• Select Digits from the Style menu (Fig 3.93) to modify the format of the numbers if
adjacent labels conflict, for example.  Shift-click to select existing labels before changing the
default format.

• Select Text Labels from the Edit menu to add text labels.  Drag a rectangle to create a text
window.  Enter text in the usual word processor manner.

• Select Optimize to shrink-fit a text window to the added text.  To resize again, press the
option key while dragging the resize tab in the lower right corner of the frame.

If you did not select a desired type of label,

• Select Change Plot Specs (Fig 3.89) to redraw the same plot but with a different set of
labels chosen from the Specifications dialog box.

Fig 3.89 Goodies menu
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• Select Zoom (Fig 3.89) to enlarge a rectangular portion of the plot (Single—Fig 3.90) or to
plot one or more equal-sized rectangular regions (Multiple).  In the latter case, you can
combine the composite of these rectangles to produce an enlarged view of the plot.  See the
discussion for screen size plots. If you are using a LaserWriter for output, you can choose
automatic size changes from 25 to 400% of the standard page at print time.  (See the
corresponding discussion for screen-sized plots.)

Fig 3.90 Zoom window

• Select Change value increments (Fig 3.89) to adjust the number and value of contour
values (Fig 3.91).
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Fig 3.91 Digits menu

You can prescribe any three of the four values—minimum, maximum, increment, and
number of increments—and have MP calculate the remaining value.  The OK button is not
enabled by MP until such a consistent set has been calculated.

• Use the Digits button to format the numbers.

• Edit the minimum and maximum values for conveniently read values.

• Set either the increment size or the number of increments and click opposite the other to
calculate a compatible value.  The OK button is not enabled until you have done this.  If
more than 20 increments are needed, you will be required to alter the requested values to
achieve conformity with this limit.

The FontSize menu (Fig 3.92) allows you to change the size of selected text or change the
size of text you now enter.  The sizes listed in outline style are available in the system file;
the other sizes are synthesized from an existing size.
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Fig 3.92 FontSize menu

Use the Plain, Bold, Italic, Underline, Outline, and Shadow styles (Fig 3.93) as you would in
your word processor.

Fig 3.93 Style menu

• Select Erase Background to blank the background around a label.  To restore the
background for a label, shift-click to select the label and click Erase Background to remove
the check.

• Select Left, Middle, or Right to align future text entries within the label field.  Shift-click
to modify existing labels.

• Select Digits...  (Fig 3.93) to modify the display format.

MP provides very great flexibility in creating and labeling plots.  When ready to examine
tabular results,
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• Select Library from the File menu.

3.7  LIBRARY Module. 

The Library module provides tools to enable you to initiate new projects, to modify existing
problems, and to examine the numerical results of existing projects.  It provides the primary
access to tabular results—screen and printed.  (Note: You prepare graphical results in the Plot
module, not the Library module.)  The Library module also creates a master data file to
coordinate the creation of the project files.  This master file maintains the status flags for each
of the data files.  If you wish to solve a problem which is a variation of an existing project, you
can duplicate the problem formulation files in this module.

If you have not opened a project when you enter this module, the Library module allows you
to open a project, create a new project, or duplicate an existing project.

The usual  menu (Fig 3.94) contains a description of MacPoisson, a description of the open
(active) project, a context specific help reference to a help message in the Appendix, and a
demo mode enable/disable command.

  
Fig 3.94 Library menus

The File menu allows you to create a new project, open an existing project, or close an open
project.  In addition you can duplicate the input files of an existing project so you can study a
variant of the existing project.  You can print the data files of an open project on ImageWriters
and LaserWriters.

This menu allows branching to the main menu.  Quit allows you to exit MP.

Consider the handling of each alternative—an existing project, create a new project, and
duplicate an existing project (Fig 3.95).
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Fig 3.95 Library module screen (viewed when no project is open)

3.7.1 Examine an Existing Project.

From the Finder (not from within MP), a project folder (Fig 3.96) contains the notebook icon
(master file) and icons for notebook pages (data files).

Fig 3.96 MP file icons
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Fig 3.97 Project status

Refer to the Appendix for a description of the structure for each file.  You can read and edit
these files from within the Library module when the project is open.

• If necessary, open the Heated Pot project.

Note: If no project is open, the first screen displayed is the Library module (Fig 3.95); if a
project is open, the Project Status (Fig 3.97) is the first screen displayed.

The project status screen lists the 18 data files listed in the master file.  File names consist of
the project name and a period plus a descriptor which indicates the type of file.

The first column indicates which MP module created the file.

The second column provides the file number which corresponds to the order in which you
created the files.

The third column indicates whether a file exists. A blank means no file exists, a “T” means
the file is a text file and can be read by a word processor.  A “B” means the data has been stored
as a binary file.  Binary files can be created and read more quickly because the data need not be
translated.  MP can translate the binary file into a text file (Fig 3.98); this slows file access but
allows you to examine and modify these files.

You can change the file format. If you modify anything in a file, immediately correct the
change, and then close the window a format translation occurs.
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Fig 3.98 Change file format

A dot in the fourth column indicates that the file status is active and prevents the use of
inconsistent data files.  If you change the contents of an input file, MP makes all files inactive
which are now inconsistent and removes the dot in the status column.

The filename appears in the fifth column.  See the Appendix for a description of the contents
of these files.

The last column indicates the file size.  The number before and after the comma corresponds
to binary files and text files, respectively.

Click on a file name to select it. The “Geom” file has been selected in Fig 3.99.  Click on the
open button to open the file.  Alternatively, double-click on the file name to open it.
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Fig 3.99 Examine a file

Fig 3.99 shows the geometry file which is described in the Appendix.  As an academic exercise
or to gain greater flexibility, you can create these files directly from within the Library.

When a data file is open, another set of menus becomes available.

Only the Help number changes on the  menu; the File menu (Fig 3.100) does not change.

    
Fig 3.100 Library menus
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The standard Cut, Copy, Paste, and Clear commands appear on the Edit menu.  Cut and Copy
are enabled only when text is selected; Paste is enabled only when the Clipboard contains text.
The last command, File Attributes, allows you to change (or set) the size of the arrays in the
file, as was discussed in the introduction to this section.

The Numbering menu provides line numbering for the file.  Use All numbers to number the
entries consecutively.  Group numbers identify the data class for each line, and the lines are
numbered consecutively within each class.  Use Renumber to refresh the line numbers if you
have edited the file.

Fig 3.101 The mesh file

When you have selected a file (Fig 3.97), MP enables the Attribs button.

• Click the  Attribs button to obtain the following (Fig 3.102).
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Fig 3.102 Set file attributes

You can change the status flag if you are confident the data files are compatible.  If you create
data files within the Library module, you set the array sizes here.  You can examine the
contents of inactive files.

• Click Cancel to abandon any changes or click Change to accept changes.

• Double click a file name (Fig 3.97) to view the output listing (Fig 3.103).

Fig 3.103 Output listing

You cannot edit the output listings from within MP.  See the Appendix for a discussion of the
structure of the output files.

• Click the square box in the top left corner of the window to close the window.

3.7.2 Create a New Project.

If no project is open, click on Create New Project or select Open Project from the File menu.

• If necessary select a disk and folder.

• Enter a project name (Fig 3.104) and click save.
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Fig 3.104 Name project

Fig 3.105 Describe project

• Provide a project description (Fig 3.105).

• Select a problem type.

• Note the available memory for the project.

• Click continue.
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3.7.3 Duplicate a Project.

To use an existing project to create a template for a variation of the problem,

• Open the project you want to duplicate if it is not already open, and

• Select Duplicate Project... from the File menu (Fig 3.100) of the Library module.

• Supply a file name (Fig 3.107) or accept the sequentially number default.
Change disks or drives if necessary.

• Click Save.

Fig 3.106 Name duplicate file

Fig 3.107 Initialized files

MP creates a new folder with the project name and a script ƒ appended.  It duplicates a new
master file and the seven input files.
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When you open the new data files, use the About Project command from the  menu to
update the project description.  MP allows  you to begin revision of the project files with any
input module.
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Chapter 4

Computational Details

This chapter presents a brief overview of the computational details handled by MacPoisson.
Refer to Applied Finite Element Analysis (Segerlind, 1976,1984) and The Finite Element
Method  (Zienkiewicz, 1977) for additional details.

4.1 Function Variation Within An Element.

Poisson's equation describes several field problems of interest, e.g., steady-state heat
conduction, electrostatics, ideal fluid flow, seepage in porous media, etc.  In this example we
restrict attention to steady-state heat conduction.  Examples from several other areas of
interest are described in Chapter 5.

In our use of the finite element method in steady-state heat conduction in solids, temperature
is expressed as a continuous function within each element.  We select both the shape of the
element and the form of the temperature function, but they are related.  Element shapes can
be triangles or quadrilaterals with straight or curved sides.  Straight-sided elements require a
node at each vertex.  Curved-sided elements require additional nodes to define the shape of
the element sides.  In this version of MP we use only straight-sided triangular elements.

4.1.1 Shape Functions.

The temperature within an element is determined by interpolation using a set of shape
functions.  Commonly, shape functions are polynomials of the nodal coordinates, so the order
of the polynomial depends on the number of nodes in the element.  Here, we use the simplest
element, a 3-node straight-sided triangle and a multilinear interpolation function.

The shape functions used for a 3-node triangular element are linear functions of the
coordinates.  Thus, element temperature is a linear function of the coordinates.  Consider the
two-dimensional element shown in Figure 4.1.

Fig 4.1.  Representation of a 3-node triangular element

Let temperature be represented by the symbol u, which is a continuous function within this
triangular element, i.e., u (x,y).  The temperature values at the nodes i, j, and k are Ui, Uj , and

Uk, respectively.  Temperatures throughout the element are defined as linear combinations of

the nodal values:
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u(x, y) = Ni(x, y) Ui + Nj(x, y) Uj + Nk(x, y) Uk 4.1

or, in matrix form,

u = [ Ni  Nj  Nk ] 

 



 Ui

Uj

Uk 




 = [ N ]T { U } 4.2

where Ni, Nj , Nk  are shape functions (Segerlind, 1976, 26; Zienkiewicz, 1979, 23, functions of

the coordinates) defined by
– coordinates of the nodes for the element and
– coordinates of the point of interest.

Shape functions used here are linear functions of x and y (or r and z for axisymmetric bodies)
within an element, and are defined as:

Ni = [ ai + bi x + ci y ] / 2A

Nj = [ aj + bj x + cj y ] / 2A 4.3

Nk = [ ak+ bkx + ck y ] / 2A

where A  is the area of the element
(x,y) are the coordinates of the point within the element.

In matrix form, the shape functions are a column vector:

[ N ] = (1 / 2A) 

 



 ai + bix + ciy

aj + bjx + cjy

ak + bkx + cky 




4.4

where constants are defined from the node coordinates as follows:

2A = XjYk + XiYj + XkYi − XjYi − XkYj − XiYk 4.5

ai = XjYk − XkYj
aj = XkYi − XiYk
ak = XiYj − XjYi

bi = Yj − Yk
bj = Yk − Yi 4.6

bk = Yi − Yj

ci = Xk − Xj
cj = Xi − Xk
ck = Xj − Xi

Example 4.1 - Shape Functions for a 3-Node Triangle.
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Fig 4.2.  A 3-node triangular element example

Evaluate the shape functions for the element shown in Figure 4.2.

Coefficients in the shape functions are determined by substituting the nodal coordinates of this
element into equations 4.5 and 4.6:

2 A = XjYk + XiYj + XkYi − XjYi − XkYj− XiYk

2 A = (5)(5) + (2)(1) + (4)(2) − (5)(2) − (4)(1) − (2)(5) = 11

ai = XjYk − XkYj = (5)(5) − (4)(1) = 21
aj = XkYi − XiYk =  (4)(2) − (2)(5) = −2
ak = XiYj − XjYi  = (2)(1) − (5)(2)  = −8

bi = Xj − Yk
bj = Yk − Yi  = 5 − 2  = 3
bk = Yi − Yj  = 2 − 1  = 1

ci = Xk − Xj  =  4 − 5 =  −1
cj = Xi − Xk  = 2 − 4  = −2
ck = Xj − Xi  = 5 − 2  = 3

For this element the shape functions evaluated using equation 4.3 are:

[ N ] = ( 1 / 2A ) 

 





 ai + bix + ciy

aj + bjx + cjy

ak + bkx + cky 







 = ( 1 / 11 ) 

 






21 − 4x − y

−2 + 3x − 2y

−8 + x + 3y  








Compute the shape function values at the nodes of this element:
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◊  at node i  (2,2)

Ni = [ 21 − (4)(2) − (1)(2)] / 11  = 1
Nj = [ −2 + (3)(2) − (2)(2)] / 11  = 0
Nk = [−8 +  (1)(2) + (3)(2)] / 11 = 0

◊ at node j  (5,1)

Ni = [ 21 − (4)(5) − (1)(1)] / 11  = 0
Nj = [ −2 + (3)(5) − (2)(1)] / 11  = 1
Nk = [−8 + (1)(5) +  (3)(1)] / 11 = 0

◊  at node k  (4,5)

Ni = [ 21 − (4)(4) − (1)(5)] / 11  = 0
Nj = [ −2 + (3)(4) − (2)(5)] / 11  = 0
Nk = [−8 + (1)(4) +  (3)(5)] / 11 = 1

This illustrates an important property of element shape functions:  they are unity at their node
and zero at the other two nodes.  Elsewhere in the element they have values between zero and
one.

4.1.2 Computing Temperatures.

A temperature within an element is defined by the product of the shape functions and the
temperatures at the nodes:

u = [ N ]T { U } = [ Ni  Nj  Nk ] 

 



 Ui

Uj

Uk 




4.7

Thus, a check of the shape function coefficients is this:

◊ at node i,  u must equal
Ui, which requires that

Ni = 1
Nj = 0
Nk = 0

◊  at node j,  u must equal
Uj, which requires that
Ni = 0
Nj = 1
Nk = 0
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◊ at node k,  u must equal
Uk, which requires that

Ni = 0
Nj = 0
Nk = 1.

The shape functions for this element, being unity at their node and zero at the other nodes,
produce the proper interpolated temperature values at the nodes.  You can use these shape
functions  to determine the temperature u(x,y) at any point in this element by substituting the
coordinates of the selected point into the shape function equations.

Example 4.2  -  Temperature at a Point.

For the element used in the previous example, determine the temperature at the interior
point with coordinates (3,3).  Now compute the shape functions at this point using the
element shape functions obtained in the previous example and coordinates (3,3):

[ N ] = ( 1 / 11 ) 
 

 21 − (4)(3) − (1)(3)

−2 + (3)(3) − (2)(3)
−8 + (1)(3) + (3)(3)

 

 



= (1 / 11 ) 
 

 6

1
4 




and the temperature is defined by equation 4.7:

u = [ N ]T { U } = ( 1 / 11 ) [ 6  1  4 ] 
 

12

20
25 




= 17.45

Thus, using the shape function and the known temperature values at the nodes
(Ui, Uj Uk), you determine the temperature value u(3,3) to be 17.45.  Likewise, you can
determine temperature values at all points within any element using the shape functions for
the selected element and the temperature values at the nodes of that element.

4.1.3 Derivatives of Functions.

The finite element equations for steady state heat conduction presented below are based on
derivatives of the temperatures [Segerlind, 1984,138; Zienkiewicz,1979, 423].  Recall that the
temperature functions within a 3-node triangular element are linear with respect to each
coordinate direction and are used to obtain temperatures from:

u = [ N ]T { U } = ( 1 / 2A ) 

 



 ai + bix + ciy

aj + bjx + cjy

ak + bkx + cky 




T

 { U } 4.8

The element temperature gradient is:

 


∂u / ∂x

∂u / ∂y 
  = 

 


∂N / ∂x

∂N / ∂y 
  {U} = [B] 

 



 Ui

Uj

Uk 




4.9



Page 174

174

where [B] is the shape function derivative matrix given by

[B] = 
 


∂N/∂x

∂N/∂y 
  = 

1
2 A

 
 


bi

ci
 

bj

cj
 

bk

ck  
 4.10

This illustrates that the derivatives of the temperatures in an element are constants.  This also
requires that you divide your problem into many elements when 3-node triangles are used
and the temperature gradient is of interest to you.

Example 4.3 - Derivatives Of Temperature For A 3-Node Triangle.

Evaluate the derivatives of the temperature within the element shown in Figure 4.2.  To do
this use equations 4.9 and 4.10 together with coefficients calculated in example 4.1:

 
∂u / ∂x
∂u / ∂y 

 = (1/11) 
 


−4
−1

 
3
−2

 
1
3 


 

 12

20
25 




  =  
 

3.36
2.09 

Within this element, the temperature gradient is constant as indicated by the vector shown in
Figure 4.3.

Fig 4.3.  Derivatives of the temperature in an element

4.2 Finite Element Equation Formulation.

The general form of finite element equations is a matrix product of a square stiffness
(coefficient) matrix and a column temperature vector set equal to a column force (source)
vector :

nxn   nx1      nx1  (rows x columns)
[K] {U} = {F} 4.11

where
[K] is a square, symmetric "stiffness" matrix,
{U} is the "unknown" temperature vector,
{F} is the "force" vector, and
 n is the number of "unknown" temperatures.



Page 175

175

A matrix equation of this type is formed for each element and combined into a global equation
for the entire problem domain.  After you form the global matrix equation for the entire
problem domain, you apply boundary conditions to modify the equations.  Solution of the
modified equations yields the temperatures for the given problem and boundary conditions.
Then if you desire, you can evaluate element temperatures and gradients and nodal gradients.

In 2-dimensional (and axisymmetric) heat transfer problems, each node has one "unknown"
temperature.  Symbols i, j, and k denote node numbers and subscripts of the "unknown" nodal
temperatures, U, in counterclockwise order around an element as shown in Figure 4.4.

Fig 4.4.  Notation for nodal temperature values

Because there is one unknown temperature at each node, the matrix equation for each
element has three "unknown" nodal temperatures.  You evaluate the temperature at a point
in the element from the shape functions and nodal temperatures as follows:

1x1   1x3    3x1  (rows x columns)

u = {N}T
 {U} 4.12

where

{U}  =  

 



 Ui

Uj

Uk 




    and   {N}  =  

 



 Ni

Nj

Nk 




4.13

and  (Ui, Uj Uk) are the linear shape functions defined in equations 4.4 and 4.6.

You form the matrix equation for each element using derivatives of the shape functions and
thermal properties of the elements.  These equations are of the form of equation 4.11 and differ
slightly depending on the coordinate system used.

        4.2.1 Two-dimensional Cartesian Coordinate Systems.

The finite element matrix equation describing 2-dimensional conduction heat transfer in a 3-
node triangular element is:

                  3x3              3x1       3x1      (rows x columns)

 
  t  A  [B]T

 [D]  [B]  
  {U}  = {F} 4.14

where
   t is the thickness of the element,
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  A is the element area,
[ B ] is the shape function derivative matrix (equation 4.10),
[ D ] is the material property matrix.

The material property matrix is

[D]  = 
 


kx

0
 

0

ky 
 4.15

where  kxand ky  are thermal conductivity in the x and y directions, respectively.

       4.2.2 Axisymmetric Systems.

For axisymmetric (r-z coordinate) systems, the 3-node triangular element is a triangular toroid
(a triangle of rotation about the z-axis).  You can evaluate the finite element equations at the
element centroids with minimal error if the elements are small [Segerlind, 1976, p201].

The finite element matrix equation defining axisymmetric conduction heat transfer in a 3-
node triangular element is:

                        3x3               3x1      3x1    (rows x columns)

 
  2π r̄  A  [B]T

  [D̄] [B]  
   {U}  = {F} 4.16

Note that A is the element area,
2π r̄ is an equivalent thickness for the element, and
[D̄] is the material property matrix evaluated at the element centroid defined as:

[D̄]  =  
 


r̄ kr

0
 

0

r̄ kz 
 4.17

where
r̄  is the r-coordinate of the element centroid.

4.2.3 Element Equations for Steady-State Heat Conduction.

Note that both equations 4.14 and 4.16 match the form of equation 4.11.   The force (or source)

matrix {F} is zero prior to application of boundary conditions.  The element stiffness matrix
[K] for steady-state heat transfer is the 3-by-3 matrix evaluated by the matrix multiplications
shown in the first term of equations 4.14 and 4.16.  The 3-node triangular elements have 3
"unknown" temperatures or degrees of freedom.

The finite element equations presented are valid for any consistent set of units.  For SI (metric)
systems, sources, temperatures, and fluxes are expressed in Watts, °C, and W/m2, respectively.
Thermal conductivities are defined in W/(m °C) and thickness in meters.

If you use local node numbers for nodes i, j, and k equal to 1, 2, and 3, respectively, then
subscripts for the unknowns become 1 through 3, and both equations 4.14 and 4.16 may be
expanded to the following matrix equation:
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 







k1,1

k2,1

k3,1

 

k1,2

k2,2

k3,2

 

k1,3

k2,3

k3,3 





  

 



U1

U2

U3 




  =  

 



 F1

F2

F3 




4.18

Each of the three temperatures represents a degree of freedom (dof) for this element.  U1 is the
temperature of node 1 (dof=1), U2 is the temperature of node 2 (dof=2), and U3 is the
temperature of node 3 (dof=3).   Each stiffness coefficient, k, represents the heat source that
must be applied at one node to produce a unit increase in temperature at another node.  The
first subscript denotes the degree of freedom of the source, and the second subscript denotes the

temperature's degree of freedom.  Thus, k1,2 is the heat source applied at node 1 (dof=1) that
produces a unit increase in temperature at node 2 (dof=2).

Example 4.4 -  Finite Element Equation Formulation.

Determine the element stiffness matrix and the finite element equation for the element of
uniform thickness shown below.  Material properties are:

kx = 4 W/m °C
ky = 5 W/m °C
t = .1 m

Fig 4.5  Material properties

For this 2-dimensional element, the shape function derivative matrix is defined by equation
4.10 together with coefficients determined in Example 1:

[B] = (1/11) 
 


bi

ci
 

bj

cj
 

bk

ck 
   =  (1/11) 

 


−4

−1
 

3

−2
 

1

3 



The material property matrix is defined by equation 4.15:

[D] = 
 

kx

0
 

0

ky 
   = 

 


4

0
 

0

5 





Page 178

178

The element stiffness matrix is determined using the matrix products in the first term of
equation 4.14:

[k(e)]  = t  A  [B]T
 [D] [B]

Substituting values from above,

[k(e)]  = (0.1) (11/2) 
 




−4
3
1
 

−1
−2

3 


  

4
0
 

0
5 

 

−4
−1

 
3

−2
 

1
3 


which yields the following 3 x 3 element stiffness matrix:

[k(e)]  = (0.55) 
 




69
−38
−31

 
−38
56

−18
 

−31
−18
49  




Note that the diagonal coefficients (in bold type) are positive and have the largest magnitude
in each row and column.  Also note that the coefficients which are symmetric about the

diagonal are equal, e.g., k1,3 = k3,1 = −31.  The sum of coefficients in any row or in any column
is equal to zero.  These attributes exist in all of the element stiffness matrices and in the global
stiffness matrix produced by assembling the element matrices.

If you number nodes i, j, and k for the element of interest locally as 1, 2, and 3, respectively, the
finite element equation for this element becomes:

(−.55) 
 







69

−38

−31

 

−38

56

−18

 

−31

−18

49  







 



 U1

U2

U3 




  = 

 



 F1

F2

F3 





The force matrix is zero because no heat sources are applied to this element.  The boundary
conditions are added only after all of the element equations have been assembled into a global
matrix equation.

4.2.3 Element Equations for Steady-State Heat Conduction.

◊ Element shapes and sizes can differ because nodes need not be on a regular grid.  Nodes i, j,
and k are at coordinates:
(Xi, Yi),   (Xj, Yj), and  (Xk, Yk), respectively.

◊ Unknowns are defined by continuous polynomial shape functions in an element.  For 3-
node triangular elements, the shape functions are linear with respect to x and y (or r and z):

u(x,y) = [N(x,y)]T{U}

◊ Finite element equations are defined in a common matrix form:

[K] {U} = {F}
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◊ The element stiffness matrix is a function of node coordinates (in A & [ B ])  and material
properties (in [ D ]):

[K(e)] = t A [B]T
 [D] [B]

◊ The temperature gradient is defined within an element as:

 
∂u / ∂x
∂u / ∂y 

 = [B] {U}

and is constant throughout an element.

◊ Yet to be discussed are:
◊  Mapping from element coordinates to global coordinates
◊  Combining element equations into a global matrix equation
◊  Applying boundary conditions to the global equations
◊  Solving for "unknown" temperatures at the nodes

4.3  Global Matrices.

A finite element equation of the form of equation 4.19 exists for each element in the problem
domain.

[k(e)] {u
(e)} = {F

(e)} 4.19

where the superscript (e) indicates the element number.

MP must satisfy all of these equations simultaneously to develop a solution to the problem
posed.  Thus, it assembles a larger matrix equation (a global matrix equation from the
individual element equations to establish the total set of conditions that govern the problem
solution.  The global matrix equation must have a number of rows equal to the number of
degrees of freedom (unknowns) for the problem; for steady-state heat transfer problems, this is
equal to the number of nodes.

MP systematically combines equations from individual elements to develop a global set of
equations.  First, it establishes the global matrix equation to provide the number of rows (and
columns in the global stiffness matrix) needed for all degrees of freedom.  Then it inserts
element equations into the global matrices by adding stiffness coefficients and sources to
values in their respective global locations.  This is illustrated later.

The number of simultaneous equations existing for each element is equal to the number of
degrees of freedom (unknowns) for the element.  A 3-node triangular element has three
degrees of freedom if one unknown exists at each node as with Poisson’s equation (or six
degrees of freedom if two unknowns occur at each node as is the case with two-dimensional
elasticity).

Figure 4.6 shows a body with elements 1, 2, and 3 and nodes 1, 2, 3, 4, and 5.  Because one
unknown temperature exists at each node, three equations are required for each element.
Degree of freedom numbers are the same as the node number.
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Fig 4.6.  A body with three 3-node triangular elements

For element 1, containing nodes 1, 4, and 2, the element equation is:

 









k
(1)
1,1

k(1)
2,1

k
(1)
4,2

 

k
(1)
1,2

k(1)
2,2

k
(1)
4,2

 

k
(1)
1,4

k(1)
2,4

k
(1)
4,4 









  

 






 u
(1)
1

u(1)
2

u
(1)
4  








 =  

 






 f
(1)
1

f(1)
2

f
(1)
4  








4.20

Values of the stiffness coefficients depend on the geometry and material properties of the
element as discussed earlier but are designated only by symbols for this illustration.  Note that
a complete matrix equation would include a row and a column for degree of freedom 3;
because these coefficients are zero, they are not shown here.  The total number of columns
required to display this element stiffness matrix (including intermediate zero values) is called
the bandwidth (BW) of the element stiffness matrix, given by:

BW = (highest dof) - (lowest dof) +1                            4.21
which gives for element 1,

BW
(1)

 = 4 − 1 + 1  = 4

Thus, in a global matrix format, element 1 equations would require 4 rows, and the stiffness
matrix would have 4 rows and 4 columns if the intermediate row and column were included.

For element 2, containing nodes 2, 4, and 3, the element equation is:

 









k
(2)
2,2

k(2)
3,2

k
(2)
4,2

 

k
(2)
2,3

k(2)
3,2

k
(2)
4,3

 

k
(2)
2,4

k(2)
3,4

k
(2)
4,4 









 

 






 u
(2)
2

u(2)
3

u
(2)
4  








 = 

 






 f
(2)
2

f(2)
3

f
(2)
4  








                                               4.22

The bandwidth for element 2 is

BW
(2)

 = 5 − 3 +1 = 3.

Because the node numbers for element 2 are consecutive, this bandwidth is the minimum that
can occur for a 3-node triangular element with one degree of freedom per node.
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For element 3, containing nodes 3, 4, and 5, the element equation is:

 









k
(3)
3,3

k(3)
4,3

k
(3)
5,3

 

k
(3)
3,4

k(3)
4,4

k
(3)
5,4

 

k
(3)
3,5

k(3)
4,5

k
(3)
5,5 









 

 






 u
(3)
3

u(3)
4

u
(3)
5,5 








 = 

 






 f
(3)
3

f(3)
4

f
(3)
5  








4.23

The bandwidth for element 3 is

BW
(3)

 = 5 − 3 + 1 = 3.

The global matrix equation for the body being considered has five degrees of freedom (five
nodes with one dof each).  The values in the global matrices are the sums of the corresponding
values in all of the element matrices.  For example, for a 3-element body, the force component
in the ith row of the global force matrix is

fi = f(1)
i  + f(2)

i  + f(3)
i 4.24

and the global stiffness coefficient in the ith row and jth column is

ki,j = k(1)
i,j  + k(2)

i,j  + k(3)
i,j 4.25

Because the unknown temperature for each degree of freedom is the same regardless of the
element equation from which it arose, it appears in the global equation without superscripts.
Thus, the global matrix equation for the 3-element body being considered becomes

 ←bandwidth →                

 











k1 , 1

k2,1

0

k4,1

0

 

k1 , 2

k2 , 2

k3,2

k4,2

0

 

0

k2 , 3

k3 , 3

k4,3

k5,3

 

k1 , 4

k2 , 4

k3 , 4

k4 , 4

k5,4

 

0

0

k3 , 5

k4 , 5

k5 , 5  









  

 









 u1

u2

u3

u4

u5 











  = 

 









 f1

f2

f3

f4

f5 











4.26

The primary diagonal of the global stiffness matrix includes coefficients
k1,1, k2,2, k3,3, … , k5,5 .  Coefficients with reversed subscripts are symmetric about the primary

diagonal and are numerically equal: k2,1 = k1,2, k2,3 = k3,2, k4,5 = k5,4 , etc.

Note that the global stiffness matrix contains zeros (also symmetric about the primary
diagonal) where no nonzero element stiffness terms occurred (e.g., no element contained

nodes with degrees of freedom 1 and 5, so k1,5 = k5,1 = 0).  Note also that all nonzero coefficients
lie within a band about the primary diagonal.  Matrices of this type are called banded matrices.

Because the global stiffness matrix is a banded symmetric matrix, only the diagonal and half of
the nonzero numbers (shown in bold type in equation 4.26) are unique.  The bandwidth of the
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global stiffness matrix is the minimum number of columns required to retain all unique
numbers in the stiffness matrix.  By condensing the global stiffness matrix as shown in
equation 4.27, the bandwidth becomes less than the number of degrees of freedom; thus, 4
rather than 5 columns are kept to retain all unique stiffness coefficients.

          ← bandwidth→

[K̃] = 

 











k1 , 1

k2 , 2

k3 , 3

k4 , 4

k5 , 5

 

k1 , 2

k2 , 3

k3 , 4

k4 , 5

0

 

0

k2 , 4

k3 , 5

0

0

 

k1 , 4

0

0

0

0 









 4.27

The bandwidth for the global stiffness matrix as shown in equations 4.26 and 4.27 for the 3-
element body is 4.

The numbers in the condensed stiffness matrix (equation 4.27) are defined so that the primary
diagonal of the original matrix becomes the first column of the condensed matrix; subsequent
diagonals are subsequent columns in the condensed matrix, e.g.,
k̃1,1 = k1,1,  k̃2,1 = k2,2,  k̃3,1 = k3,3,  k̃1,2 = k1,2,  k̃2,2 = k2,3,  k̃3,2 = k3,4 , etc.  Here, the condensed
matrix contains only 20 (5 x 4) numbers as compared to the 25 (5 x 5) numbers in the original
stiffness matrix.  The amount of space saved by condensing the matrix in this manner depends
on the number of unknowns and the manner in which nodes were numbered.

The bandwidth of the global stiffness matrix (and the number of columns in the condensed
matrix) depends on where the nonzero coefficients occur in the global stiffness matrix, which
depends on the bandwidths of the included element stiffness matrices.  The largest element
bandwidth becomes the bandwidth of the global stiffness matrix.  Larger bandwidths require
more computer memory and longer computation times; therefore, it is important to number
nodes in a manner that minimizes the bandwidth.

When you manually assign node numbers, you can achieve smaller bandwidths by
numbering nodes sequentially in the direction of smaller mesh dimensions.  For example,
consider the mesh in Figure 4.7 with two different node numbering schemes.  Numbering first
along the longer side (side with the most nodes) as shown on the left results in a larger
bandwidth than numbering parallel to the shorter side.  In more complex geometries or in
automatic node numbering approaches, node renumbering algorithms can be used to reduce
the bandwidth after the entire mesh has been defined.  MP uses the Collins renumbering
algorithm to reduce the bandwidth of the global stiffness matrix before the element equations
are assembled to produce the condensed stiffness matrix.  Global stiffness matrices are stored in
the condensed format.



Page 183

183

BW = 7                                    BW = 4
Fig 4.7.  Bandwidths resulting from two node numberings

Example 4.5 - Global Stiffness Matrix Assembly.

A mesh has numerous elements with a total of 50 degrees of freedom.  The element stiffness
matrices for elements 1 and 2 are given below.  Combine these two element stiffness matrices
as a first step in assembling a global stiffness matrix.

[k(1)] = 

 




12
−5
−7

 
−5

8
−3

 
−7
−3
10 




   

dof  

1

  

3

  

6

[k(2)]  =  

 




7
−2
−5

 
−2

9
−7

 
−5
−7
12 




dof  

2

  

3

  

6

The global stiffness matrix has 50 degrees of freedom, the first 6 of which are shown below.  All
remaining coefficients are zero at this time.  You obtain the first coefficient in the global
stiffness matrix,

k1,1,  by adding the k
(1)
1,1 coefficient from the element 1 matrix (k

(1)
1,1 = 12)

 to that from element 2

(k(2)
1,1 = 0), yielding k1,1 = 12 + 0 = 12.

 (The element 2 matrix has a zero value for  k
(2)
1,1

 and is not shown because element 1 does not have dof #1.)  Both element matrices have
degrees of freedom 6 and 3; therefore,

k6,3 = k(1)
6,3 + k(2)

6,3  = −3 + (−7) = −10.
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You can obtain all other coefficients in the global stiffness matrix similarly by adding
corresponding coefficients from the element matrices.

[k(1+2)] = 

 














12
0

−5
0
0

−7
0

…

 

0
7

−2
0
0

−5
0

…

 

−5
−2
17

0
0

−10
0

…

 

0
0
0
0
0
0
0

…

 

0
0
0
0
0
0
0

…

 

−7
−5

−10
0
0

22
0

…

 

0
0
0
0
0
0
0

…

 

…
…
…
…
…
…
…
… 














dof  

1

  

2

  

3

  

4

  

5

  

6

  

7

 

4.4  Material Properties.

Material properties used in steady-state heat transfer problems include the following:

kx

  or
kr

  thermal conductivity in the x- or r-coordinate direction

ky

  or
kz

  thermal conductivity in the y- or z-coordinate direction
 t              thickness (when not axisymmetric).

You can use any consistent set of units for these properties.  Sample sets of units for material
properties are presented in Table 4.1.

Table 4.1.  Units for Material Properties.
Property SI Units English Units
Thermal conductivity W/(m °C) Btu/(ft.°F.hr)
Thickness meters feet

You specify each property for each element, thus allowing widely varying material properties
throughout the body, which is characteristic of biological problems.

4.5 Boundary Conditions.

Boundary conditions impose particular heat transfer conditions or temperatures at points or
on surfaces in the problem.  Without them there is no well-posed problem since all
temperatures would be zero.  In solving the finite element equations, boundary conditions
define specific constraints placed on the matrix equations to yield nodal temperatures
appropriate for the physical problem being analyzed.  Boundary conditions allowed in this
program include heat sources (or sinks) applied at nodes, heat fluxes applied on boundaries,
convection on boundaries, and prescribed temperatures at nodes.  Convection is specified by a
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convection coefficient and a fluid temperature.  Specification of no boundary condition along
an exterior boundary is equivalent to a perfectly insulated surface (zero flux across the
boundary).

Nodal heat sources, heat fluxes, and convection define the source vector on the right-hand
side of the matrix equations.  Convection also modifies the stiffness matrix coefficients.  Fixed
temperatures signify fewer actual unknowns than the number of equations and modify the
stiffness coefficients and source vector to yield the prescribed nodal temperature values.  You
can specify surface fluxes in coordinate directions or in directions normal to boundaries; MP
converts them to components normal to the surfaces before converting them further to point
heat sources that MP adds to the right-hand side of the matrix equations.

Two sets of units commonly used for boundary conditions are given in Table 4.2.  You can use
any consistent set of units.

Table 4.2.  Units for Boundary Conditions.
Variable SI Units English Units
Heat source Watts Btu/hr
Heat flux W/m2 Btu/(hr ft2)
Convection coefficient W/(m2°C) Btu/(ft2 hr °F)
Temperature °C °F

Each boundary condition type modifies the global set of finite element equations in a specific
way.  Some affect only the global source (force) vector, while others alter both the stiffness
matrix and source vector.  Some modifications are made on an element basis before global
changes are made, but others change the global matrices directly.

 The element source vector defines effects of heat sources in elements, surface heat fluxes in
elements, and convection on element surfaces.  The element source vector is the sum of
sources from designated point heat sources and surface fluxes (including convection):

{f(e)} = {f(e)
p } + {f(e)

s } 4.28
where

{f
(e)} is the element source vector,

{f(e)
p } is the element point heat source vector, and

{f(e)
s } is the element surface heat source vector.

4.5.1 Point Heat Source.

The point heat source vector is dependent on the location of the source in the element.  (Heat
sinks are considered as negative heat sources).  If the source is located inside an element, then
MP must distribute the point heat source to the nodes in the element matrix as follows:

◊  for 2-dimensional problems -
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{f(e)
p } = Q 

 



 Ni

Nj

Nk 




4.29

where

{f(e)
p } is the element point heat source vector,

i, j, and k  are the node numbers in the element,
Ni, Nj, and Nk are shape functions evaluated at the location  of  the source, and
Q  is the point heat source value.

◊  for axisymmetric problems -

{f(e)
p }= r̄ Q 

 



 Ni

Nj

Nk 




4.30

where r̄  is the r-coordinate of the element centroid [Segerlind, 1976, 199].

Once the program distributes the heat sources to nodes, they are considered as any other point
heat source actually occurring at a node.  MP adds the point heat sources at nodes directly to
the rows of the global source vector that correspond to these nodes.  For 2-dimensional
problems, a source of value Q at node number n requires the addition of Q to the nth row of
the global source vector.  In axisymmetric systems, the product
r̄ Q

 is added to the global source vector (where r̄  is the r-coordinate of node n); if the r-
coordinate was included during distribution using equation 4.30, only Q would be added.

4.5.2  Surface Fluxes.

Heat flux across a boundary of an element adds or removes heat from the element.  Thus,
element source vectors are defined somewhat similarly for specified boundary fluxes and for
surface convection.  For specified fluxes, q is the prescribed value (positive in the outward
normal or coordinate direction).  For convection, the surface flux is defined as:

q = h Tf 4.31
where

q  is the flux,
h  is the convection coefficient, and
Tf is the fluid temperature.

MP converts fluxes to equivalent heat sources and allocates them to the nodes on the surface
where the flux occurs.  Equivalent source values are:

◊  for 2-dimensional problems

{f(e)
s } = q t Li,j / 2  

 

1

1
0 




4.32

where
q is the flux,
t is the element thickness,
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Li,j is the length of the element side where the flux occurs, and

{f(e)
s } is the element source vector from surface sources.

As shown, the equivalent source value,
q t Li,j, is distributed equally between the nodes i and j which mark the ends of the element side
where the flux occurs.

◊  for axisymmetric problems -

{f(e)
s } = 2π q Li,j / 6 

 



 (2 Ri + Rj)
(Ri + 2 Rj)

0  




4.33

where
q is the flux normal to the surface,

  Li,j is the length of the element side where the flux occurs, 
Ri and Rj are r-coordinates of nodes i and j, and

{f(e)
s } is the element source vector from surface flux.

MP does not distribute the equivalent source value, 2 π q Li,j (Ri + Rj) / 2,  equally between
nodes bordering the side because nodes at different distances from the z-axis (axis of symmetry)
represent different areas.  The r-coordinate values of the nodes used in equation 4.33 distribute
the heat appropriately to these nodes.

4.5.3  Surface Convection.

Convection heat transfer across a surface is proportional to the difference between the
temperature of a fluid contacting the surface and the surface temperature.  MP modifies both
the global source vector (described above) and the global stiffness matrix to account for this
temperature-dependent boundary condition.  Element stiffness matrices are defined below for
2-dimensional and axisymmetric problems.  In each case, MP adds the coefficients of the
element stiffness matrix,

[ k(e)
c ], to the coefficients of the global stiffness matrix in rows and columns corresponding to

the proper degrees of freedom.

◊  for 2-dimensional problems -

[ k(e)
c ] = h t Li,j / 6  

 




2
1
0

 
1
2
0

 
0
0
0 




4.34

where
h  is the convection coefficient,
t  is the element thickness,
i and j  are the nodes on the side where convection occurs, and
Li,j is the length of the element side.



Page 188

188

The nonzero terms occur only in the rows and columns corresponding to the degrees of
freedom for the nodes where convection occurs.

◊  for axisymmetric problems -

[ k(e)
c  ] = 2 π h Li,j / 12  

 







(3 Ri + Rj)
(Ri + Rj)

0

 

(Ri+ Rj)
(Ri + 3 Rj)

0

 

0

0

0 





 4.35

where h  is the convection coefficient,
i and j  are the nodes on the side where convection occurs,
Li,j is the length of the element side, and
Ri and Rj are r-coordinates of nodes i and j.

As shown, the stiffness coefficients affected are those with degrees of freedom corresponding to
the nodes on the side of interest; they are not affected equally.

4.5.4  Fixed Temperatures.

You can assign prescribed nodal temperatures by altering the matrix equation to yield the
desired "unknowns".  A procedure for constraining the solution is given below [Segerlind,
1984, 417].  MP performs these changes to the global matrix equation after it applies all other
boundary conditions.  This procedure fixes one temperature at a time; MP uses it repeatedly for
multiple temperature constraints.  The procedure modifies the equations to constrain the
temperature in row p to the value Up.

1.  First, set the global force (source) degree of freedom to the value that will yield the desired
displacement, Up, when only the diagonal term in this row is nonzero:

Fp = Kp,p U p . 4.36

2.  Next, adjust all other stiffness coefficients in the pth row and the pth column so that you
can set all non-diagonal coefficients in the pth row and column to zero without invalidating
the equations:

Fi = Fi − Ki, p U p   for all i ≠ p. 4.37

3.  Finally, set the non-diagonal stiffness coefficients in the pth row and pth column equal to
zero:

Kp,i = Ki,p = 0 for all i ≠p 4.38

4.6  Equation Solution.

The global set of equations modified by the boundary conditions has a number of rows equal to
the number of nodes.  MP obtains the unknowns (nodal temperatures) using the Gaussian
elimination method with back substitution [Conte, 1975,155].  However, because MP stores the
stiffness matrix in condensed form, the solution algorithm includes additional manipulation
of subscripts than normally required in the Gaussian elimination and back substitution



Page 189

189

method [Conte, S.D. 1965. Elementary Numerical Analysis: An Algorithmic Approach.
McGraw-Hill Book Co. NY].

The number of columns in the condensed stiffness matrix is equal to the bandwidth of the
original global stiffness matrix (and is less than the number of unknowns), so the condensed
stiffness matrix is not square.  The temperatures in the global solution vector is arranged
according to their degrees of freedom.

4.7 Postprocessing.

Once MP has determined the nodal temperatures, auxiliary values can be obtained.  Element
temperatures may be determined by calculating the mean of the three nodal temperatures in
each element.  This is useful for graphical display of solution temperatures, representing each
element by a different color or pattern.

Element temperature gradients having two components that are constant throughout an
element are defined by equations 4.9 and 4.10.  Example 5.4 illustrates an element temperature
gradient calculation.  If you assume the element temperature gradients to be at the element
centroids, you can use a weighted interpolation procedure to estimate temperature gradient
values at the nodes [Segerlind, L. 1976, 100].

You can calculate resultant sources acting at the nodes by the product of the global stiffness
matrix (before application of boundary conditions) and the global nodal temperature vector,
this product being defined by equation 4.39.  If these determined point heat sources were
applied alone as boundary conditions, they would produce the same nodal temperatures as
were obtained for the given problem.

{F} = [K] {U} 4.39
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Chapter 5

Solved Problems

This chapter presents a collection of verification examples.  We compare the MP results with
the theoretical solution whenever feasible.  These examples illustrate MP techniques and the
strengths and weaknesses of the triangular element.

The first three examples appeared in the student guide, but are repeated here.  At least one
example for each type of problem is included.  In addition to the necessary role of validation,
these examples provide hints for using MP more effectively.

Format for problems
Title
Project name (as on diskette)
Description of the problem, including specific issues
Screen dumps of major parts of the solution
Output (graphical and tabular)
Theoretical solution (assumption, equations, etc.)
References
Addendum

List of problems  (Click to select.)
Student version
01:       Heat conduction through a hollow cylinder    
02:      Electric potential between two eccentric metal cylinders    
03:      Bottom-heated pot revisited    

The MacPoisson™ Supplement contains an expanded list of problems.
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Project 01: Heat conduction through a hollow cylinder.

Folder:  Cylinder

   
Fig 5.1.1 Cylinder                        Fig 5.1.2 Cylinder schematic

This project models a hollow cylinder with an inside wall temperature of  T1 and outside wall
temperature of T2.  Fig 5.1.1 is a sketch of the problem, while Fig 5.1.2 illustrates how you use
the axial symmetry of the problem (i.e., the cylinder is represented by a rectangle rotated about
the z-axis).  The problem as posed could also be treated as a planar problem (a slice of two
concentric circles).

The problem has dimensions as shown above, with a wall thickness of two meters, a height of
4 meters, and a thermal conductivity (k) of 1W/m°C.  Take T1  as 100°C and T2  as 20°C.

Fig 5.1.3 Constant temperatures

The equipotential lines resulting from this solution are shown in Fig 5.1.3.  Notice that the
lack of a z temperature gradient means that the problem is essentially one dimensional and
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could have been solved as a thin ring with only two nodes on the vertical side.  A portion of
the tabular output of the program (accessible via the library function, Fig 5.1.5) shows the
temperature at different nodes along with the list (Fig 5.1.4) giving  node position vs. node
number and can thus be used to find the computed temperature at any node.

Fig 5.1.4. Node position vs. node number for nodes 55 to 65

Fig 5.1.5 Nodal temperatures

Fig 5.1.6 Node numbers in radial direction
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Fig 5.1.7 Temperature in radial direction (cf Fig 5.1.6)

Theoretical solution and comparison of results:

When you solve the differential equation governing steady state heat conduction in the tube,
the result is: T = c1 ln (r) + c2 ; with c1 and c2  easily calculated from boundary conditions.  The
solution assumes the tube to be of constant material properties, to have no heat sources or
sinks within it, and to be very long axially, thus specifying no heat flow in the z direction.
The radial variation in temperature is shown in Fig 5.1.7.

The following is the tabulated output comparing MP results (at nodes) to the results of the
theoretical solution at those nodes.

Clearly, at this resolution (20 nodes in r-direction) you obtain very accurate results.
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Pr-01 Cylinder
     Radius         MP        Theory        Error   
2.00 100.00 100.00 0.00%
2.11 94.09 94.09 0.01%
2.21 88.45 88.45 0.00%
2.32 83.08 83.08 0.00%
2.42 77.95 77.95 0.00%
2.53 73.04 73.04 0.00%
2.63 68.33 68.33 0.00%
2.74 63.80 63.80 0.00%
2.84 59.44 59.44 0.00%
2.95 55.24 55.25 0.01%
3.05 51.21 51.20 -0.03%
3.16 47.29 47.28 -0.02%
3.26 43.50 43.50 -0.01%
3.37 39.84 39.83 -0.01%
3.47 36.28 36.28 0.00%
3.58 32.84 32.84 0.00%
3.68 29.49 29.49 0.00%
3.79 26.24 26.24 0.00%
3.89 23.08 23.08 0.00%
4.00 20.00 20.00 0.00%

References:  Eckert, E.R.G., and Drake, Robert M. Jr. 1972. Analysis of Heat and Mass Transfer.
McGraw-Hill, p70.

 An interesting variation on this problem is to assume the tube to have different material
properties at different radii, thus making a composite tube.  This problem also has an easily
derivable, closed form solution.  However, it is possible to change the problem in ways which
render closed form solutions difficult, such as: by removing the "very long axially" restriction
and assuming a convection loss along the top and bottom surfaces, or by assuming a small
band of insulating or conducting material buried in the tube, or by assuming heat sources
unevenly distributed within the tube.



Page 195

195

Project 02: Electric potential between two eccentric metal cylinders.

Folder:  Eccentric Cylinder

Two metal circular cylinders of different radii and different centers, one lying completely
within the other are shown in Fig 5.2.1.  The voltage on the inner cylinder is taken to be 200
volts, while the outer cylinder is taken as ground (0.0 volts).   The potential distribution
between the cylinders is desired.

          
Fig 5.2.1 Eccentric cylinder capacitor

The geometry creation and subsequent mesh generation are tricky in this problem.   The
intermediate region generating points on the cylinders must be equally spaced to prevent
incorrect mesh generation.  Remember, MacPoisson uses a second degree curve fitting
technique to connect two endpoints with an intermediate point on the curve.  If, in this
problem, you select regions which have unequally spaced intermediate points on the inner or
outer cylinder, the result is a different paraboloid for each section, with non-continuous slope
at the region borders.

Keep in mind the desirability of roughly equilateral triangles to promote accuracy in
computations when specifying the node/size values for the problem.  The left side of the
problem tends to have longer, thinner elements if the node/side spacing is not adjusted
carefully.

Once you create the mesh, the material property and boundary condition specification is
straightforward.  Figure 1.2.2 shows the solution of the problem as graphed by MacPoisson.

The theoretical solution to this problem is possible through the use of bicylindrical
coordinates, wherein a family of orthogonal circles is defined by the relations:
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Fig 5.2.2 Equipotential lines for eccentric cylinder

h
x = 

a sin  η
cos  η − cos θ

y = 
a si n

 
θ

cosh η − cos θ

z = z

h

h = constant (circles about poles on x-axis at +a and -a).
q = constant (orthogonal circles, centers on y axis).

The solution for the problem is easily shown to be:

V = 200 
(η1 − η2)
(η1 + η2)      where;

 corresponds to the inner 200v cylinder, and
 corresponds to the outer grounded cyliner

η1 
η2

To find V at any point given Cartesian coordinates, use the following relationship between  x
and y.

η = sinh
-1

 
x sin  θ

y

where θ = tan
-1

 
y

x − a
  − tan

-1
 

y
x + a

with a = 
1

2 s
 s

4
  -  2 s

2
 ( r

2
2 + r

2
1 ) + (r

2
2 -  r

2
1
)2

 

where r1 = radius of the smaller  cylinder
r2 = radius of the larger  cylinder
  s = distance between cylinder centers
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Errors for Eccentric cylinder
Theoretical MacPoisson % Error Node #
46.759037 44.792961 4.2 22
23.257677 22.017195 5.3 29
24.038365 22.554054 6.2 38
24.177020 22.466274 7.1 47
23.537626 22.196783 5.7 56
21.767392 20.854362 4.2 110
21.758951 20.637066 5.2 119
21.249613 20.252686 4.2 128
20.356016 19.539839 4.0 155

A computer program to solve the theoretically derived potential at each node was used to
generate a table of the nodal values where the error exceeds 4.0% when compared to theory.

Clearly, even at a relatively low resolution (D.O.F. = 279), MacPoisson produces very good
results, with a maximum error of 7.1%, and with only 3% of all nodes having an error of
more than 4%.

Reference:  Moon and Spencer. 1961. Field Theory for Engineers.  D. Van Nostrand Company
Inc. Ch 13.
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Project 03: Bottom-heated pot revisited

Folder: HeatedPotIns

Fig 5.3.1 Pot with insulation

You wish to achieve a uniform temperature within the bottom-heated pot example discussed
in Chapter 3.  Suppose you want to consider the influence of the insulation of the pot on the
temperature profile of the bottom-heated flower pot.  One obvious possibility is the limiting
case of a perfectly insulated wall, which we leave as an exercise.  Consider the conditions
depicted in Fig 5.3.1.

The formulation and solution are outlined in Figures 1.3.2 and 1.3.3.

Reference:   Yang, X. and L.D. Albright. 1985. Finite Element Analysis of Temperatures in a
Bottom-heated Nursery Container. Acta Hort. No 175. pp155-165. (Also: ASAE Paper No. 85-
4048 ASAE St. Joseph, MI)
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Fig 5.3.2 Mesh generation steps for insulated pot
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Fig 5.3.3 Properties, boundary conditions, and temperature profile

Compare the results with the example in Chapter 3.
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Fig 5.3.4 The insulated and uninsulated pot temperature profiles

Notice that the four degree drop occurs over a much greater distance than in the uninsulated
case.

Fig 5.3.5 Insulated and uninsulated examples superimposed

The difference between the uninsulated and insulated cases can be displayed more clearly by
superimposing the two results (Fig 5.35).
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Appendix 1

Help Mesages

  This section provides additional procedural details for the use of MacPoisson.  The
comments are grouped by Main Menu sections.  For help, locate the context-dependent Help
number on the Apple pull-down menu; then locate the corresponding help message in this
section.  Although this is a reference section, read it at least once to become familiar with
procedural details not presented elsewhere.

Geometry                            

Help Number
1.00 Geometry Menu -
You cannot gain access into the Geometry Definition section of the program until you have
opened a project. Other options are: proceed to the Mesh Generation section, go the Library, or
return to the Main menu.

1.10 Set the Coordinate Axes Type -
This is the only opportunity for you to choose between a two-dimensional and an axisymmetric
geometry.  The element cross section appears to be triangular in either case; however, in the
axisymmetrical case the triangle sweeps out an annular region.  Mathematically, the problems
are similar but different (Segerlind, 1984, pp. 87-99 and pp. 165-176). Likewise, the plots produced
are similar in appearance but different. For axisymmetric problems, you must use the Z axis as
the axis of symmetry (see Segerlind, 1984, p. 166, Fig. 13.1).

1.11 Set Axes Limits -
This sets the horizontal and vertical limits of the plot axes.  You can adjust these limits at any
time to produce the equivalent of zooming and then restore the full view.

1.20 Add a Point (Keyboard Entry Mode) -
Add a point by typing in its coordinates, and then pressing <Return> or clicking in the OK
button. If the point is outside the range of the coordinate axes or the point already exists, then
the program BEEPs and does not enter the point.

1.21 Add a Point (Mouse Entry Mode) -
Enter a new point by clicking inside the range of the plot axes. The coordinates of the cursor are
indicated on the bottom of the panel. You can round these coordinates to the nearest integer by
pressing the Option key. If the point you select is inside a region or coincident with an already
existing point, then the program will not accept it.

1.30 Enter a Line (Keyboard Entry Mode) -
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Enter the STARTING POINT for a line by typing its coordinates (See Help  1.20) or by selecting
an already existing point with the cursor. Click on the Line icon to cancel at any time.

1.31 Enter a Line (Keyboard Entry Mode) -
Enter the ENDING POINT for a line (Help 1.20).

1.32 Enter a Line (Keyboard Entry Mode) -
Enter any intermediate points along this line by clicking into the small keypad at the bottom of
the panel. Evenly spaced mid-side points on a region produce equal-sized elements. The mesh
should be finer in areas of greater change and coarser in areas of smaller change. Therefore,
adjust the placement of the mid-side nodes to achieve this effect. Usually a placement of 0.3 to
0.7 of the distance from one corner to the next is workable. If you place the mid-side points too
near the extremities, the algorithm will fail (see Segerlind, 1976, p 369 or Steinmueller, 1974).
You can move the points on the line by dragging them with the mouse. Individual points are
not allowed to pass other points or to move off the line.  When you drag a point, its coordinates
and percentage distance along the line from starting point to ending point are displayed.  Note:
For axisymmetric problems one side of an element must be parallel to the axis of symmetry to
avoid introducing an additional approximation error.  See the Reference chapter.

1.33 Enter a Line (Mouse Entry Mode) -
Enter a line using the mouse. First, select the desired number of intermediate points from the
keypad at the bottom of the panel. Then click in the plot axes the two points that are your
starting and ending points for a line. After you select the second point, the program
automatically enters the intermediate points if you selected any number greater than zero from
the keypad. If you should click on or within a few pixels of an existing point, the program will
not add a new point; instead, it will use the existing point. As an example, Mouse Entry Mode
for a Line is most useful if you enter the corner points of a body using Point Entry, and then
quickly and easily enter the intermediate points using Mouse Entry for Lines.

1.40 Enter an Arc (Keyboard Entry Mode) -
Enter the CENTER POINT for an arc (Help 1.20).  This is the origin of the circle or ellipse of
which the arc is a part.

1.41 Enter an Arc (Keyboard Entry Mode) -
Enter the STARTING POINT for an arc (Help 1.20).

1.42 Enter an Arc (Keyboard Entry Mode) -
Enter the number of degrees measured counterclockwise from the starting point that you wish
your ending point to be.

1.43 Enter an Arc (Keyboard Entry Mode) -
Enter any intermediate points along this arc (Help 1.32, except that the points cannot be
dragged). If you enter extra points and do not use them, they are ignored.

1.44 Enter an Arc (Mouse Entry Mode) -
Instructions are the same as for Entry of a Line in Mouse Entry Mode (Help 1.33) with the
following additions:
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Enter in the boxes the starting and ending angles for the arc. The value in the box is NOT
accepted by the program until you press <Return>!

You can also enter the starting and ending angles by pressing the mouse button at the starting
angle, dragging until you reach your desired ending angle, and releasing the mouse button. You
can also click in one of the four small circles at the end of the axes lines to get four preset angles.

The four buttons to the right of the small axes are for selecting whether you want the arc to go
counterclockwise

 from starting point to ending point or clockwise

 from starting point to ending point and whether you want to create an arc from a circle

 or from an ellipse

.

1.50 Define a Region (Using Pre-existing Points) -
Define a quadrilateral region by clicking on eight points in a counterclockwise order. Lines
cannot cross but can coincide with a side of another region.  Neither can regions overlap other
regions. The first point of a region must be a vertex and not a midpoint of a side.  Adjacent
regions must share all three points of a common side.

1.51 Define a Region (See Help 1.50) -
The difference here is that you do not necessarily need to click on a pre-existing point. You can
create a region by shift-clicking eight times anywhere in the plot area.

1.60 Delete a Point (Keyboard Mode) -
Delete a point by entering the coordinates of an existing point or by clicking on the point in the
plot. You can reinstate deleted points by clicking again in the Delete Point icon.

1.61 Delete a Point (Mouse Mode) -
Delete a point by clicking on the point. You can delete a group of points by clicking in the plot
and dragging a box over the group.  (See Help 1.62.)

1.62 Delete a Group of Points -
Click inside the box to delete the points. Click outside the box to cancel.

1.70 Examine Points -
Click on a point to review its coordinates. You can modify a selected point. (See Help 1.71.)

1.71 Modify Point -
The point that can be modified is blinking. You can either type in the new coordinates for the
point or drag it with the mouse.  Clicking in the OK box, on another point, or anywhere else in
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the plot enters the new coordinates. If you move a point, its original location appears as a gray
point. You can cancel a move by clicking in the Examine icon.

1.80 Delete a Region -
Click inside a defined region to delete. Cancel by clicking in the Delete Region icon.

Mesh                                              

2.00 Mesh Menu -
The buttons on the left, as throughout, allow you to move between sections of the program. The
buttons on the top right permit entry into the two processes of the mesh generation process. A
completed process contains a check mark next to the title of the process.

2.10 Define Nodes Per Side -
Specify the number of nodes for each pair of opposite sides by selecting a side (denoted by a
small rectangular box) and then selecting a number from the palette on the left. MP
automatically identifies and matches sides of adjacent regions that are in common. MP
calculates the  number of degrees of freedom (DOF) for you as soon as you define all sides, at
which time you can generate the mesh.  You can modify your choices as often as you wish by
reselecting the side and selecting another number from the palette.

2.11 Grid Plot -
You can examine the plots for the entire generated mesh or for any regions that might exist.
You can also select the Goodies menu to examine the element numbering and node numbering
or to modify the mesh. At any time you can regenerate the mesh.

2.12 Windows -
You can examine any of the windows using the Windows menu.

2.13 Reverse Elements -
Well-shaped (nearly equilateral) elements give better computational  results; you should avoid
triangular slivers. The mesh generation routine automatically selects the diagonal of an
element pair that gives the better aspect ratio. Sometimes, however, you may wish to over-ride
this (e.g., to obtain greater symmetry in the mesh or to avoid having two sides of an element fall
in the corner of a boundary). You can reverse the element definition of two adjacent elements
by clicking inside them and pressing the reverse button.

You can not reverse elements that have sides that are collinear or nearly collinear, e.g.,
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or that have sides that form a concavity (e.g.,

If, by chance, you wish to over-ride these two exceptions, then you can press the Command and
Option keys and click the Reverse button.  Do not click OK until you have completed all mesh
modifications.

2.14 Move Nodes (See Help 2.13) -
You can move nodes by first clicking on a node and typing in new coordinates or you can move
it using the arrows. Click in one of the four directional arrows (inside the diamond and to the
left, right, top, or bottom of the Home button) to move the node; if you hold the button down,
the node moves repeatedly. MP does not allow a node to be moved so far that lines of elements
might cross. Click in the HOME button to return the node to its original position. Do not click
OK until you have completed all mesh modifications.

       
2.15 Add Nodes -
You can further refine the mesh by adding nodes and, consequently, splitting existing elements.
To add a node, select two adjacent nodes and press the Add button.  Do not click OK until you
have completed all mesh modifications.

2.20 Other Calculations (Reduction of Bandwidth and Calculation of Unique Plot Lines and
Boundary Nodes) -
Here you have the option of having the computer attempt to reduce the bandwidth of the
problem. By judiciously renumbering nodes, you can greatly expand the scope of problems that
you can solve using this microcomputer. While execution of this part of the program can
become significant, the real benefit is a more compact formulation of the global equations
needed if significant instructional problems are to fit within the limited memory. The
additional computation at this step also reduces execution time. The bandwidth reported here
represents the maximum difference between the node numbers connected through a side of a
triangular element plus one. This corresponds to the width of the array required to store the
stiffness matrix if each node has one degree of freedom.  Since the system of simultaneous
linear algebraic equations is resident in memory during the Gauss elimination solution, the
node renumbering process becomes a significant step.

Note 1: Other solution techniques allow you to find a solution if only parts of the large array are
resident at any time.

Note 2: The Collins renumbering algorithm does not guarantee optimal renumbering. MP
retains the original renumbering if the bandwidth is not reduced. If you choose to renumber,
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you have the choice of watching the progress of the computation which takes much longer than
just allowing the process to occur in memory. Calculation of unique plot lines and boundary
nodes is necessary for the next sections of the program. In the initially generated mesh, MP plots
each of the three sides of an element even when a side coincides with a previously plotted
element. To avoid redundant double plotting of common element boundaries and to identify
the boundaries required in the PROPERTIES segment of the program, MP identifies unique
lines.

Properties                                    

3.00 Properties Menu -
The buttons on the left, as throughout, allow you to move between sections of the program. The
buttons on the top right allow you to enter the two segments of properties and boundary
conditions definition. Instead of check marks, as described in Help 2.00, these buttons either
show Edit… or Enter… depending on whether data exists or not.

3.10 Property Entry -
You can assign each of the one to three properties to the entire body, to separate regions as
defined in the Geometry definition section, or to individual elements. With the Uniformity
menu you determine at what level of detail you wish to define the properties. You select the
property being defined in the Properties menu. When you have completely defined a property
for the problem, then its name in the menu appears as outline. Assignment of properties is
accomplished as follows:

You assign values to as many of the patterns in the panel at the left as you need. Clicking to the right of a pattern
(when the  cursor is active) allows you to insert or edit a value.

You can select patterns only when a pattern has a value associated with it. Select a value for entry by clicking in its
pattern box.

Assign a value to an element, to a region, or to the entire body, depending on what you selected under the Uniformity
menu, by clicking the cursor in that part of the plot. You can assign the value to a range of parts by dragging
(painting).  You can also assign values using one uniformity designation and redefine selected values using a finer
subdivision.

You can zoom the plot by pressing the Option key and dragging a box over the area that you wish to enlarge. When
you have drawn a box, then Option-click inside it. Use the Windows menu to switch between the full plot and the
zone plot. You can assign values in either mode.

3.20 Enter Heat Source -
To enter a single source, enter the source value then click in the node to which you wish the
source to be applied. To enter sources for a range of boundary nodes, hold down the Shift key (

 appears in the top left corner of the plot window) and, with the shift key still pressed, click on
a starting and then ending node. The program applies sources to these nodes in the designated,
counterclockwise order.

3.21 Enter Temperature/Potential (See Help 3.20) -
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3.22 Enter Surface Flux (See Help 3.20) -
You do not apply surface fluxes to nodes but rather to faces of the body between nodes. The
small crosses on a line indicate the locations of the midpoints of these faces. You can also add
surface fluxes in a normal (outward) direction.

3.23 Enter Convection (See Help 3.20) -
You can add convection to the front and back element faces in 2-dimensional problems.

3.24 Erase Boundary Conditions -
You can use this option in conjunction with the other three to delete boundary conditions
from the plot. It functions in the same manner as entry of boundary conditions. (See Help
3.20.)

3.25 Nodal Boundary Conditions -
Convert the input boundary conditions to equivalent values at the nodes. Surface fluxes and
convections become line sources distributed to appropriate nodes.

Solve                                                        

4.00 Solve Menu -
The buttons on the left, as throughout, allow you to move between sections of the program.
The buttons on the top right allow you to enter into the three computational segments of the
program. Completed segments are denoted by a check mark.

4.10 Solve Nodal Potentials -
Nodal potentials have been calculated. You can now click OK and proceed to the Solve Menu.

4.11 Save Intermediate Files -
Solution of nodal potentials requires several steps. During these steps the program computes
intermediate calculations. If you wish to examine these intermediates, then save them in data
files. However, if you are just interested in the final results or you wish to save time and the
large amount of disk space that these files consume, then click the No button.

4.20 Solve Potential Gradients -
The program has computed Element and Nodal Gradients and Average  Element Potentials.

4.30 Other Calculations -
The program has computed equivalent Sources and Fluxes normal to boundaries.  In other
words, these equivalent values would lead to the same result.

Plot                                                  

5.00 Plot Menu -
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You cannot gain access into the Plot module until you open a project.

5.10 Several options are available at this point-
Several options are available.  First, you can select a plot size from the PlotSize menu. The
screen size plot is useful for a quick viewing of a plot but gives you limited labeling
capabilities. If you wish to do some advanced labeling and make a print  of a plot, then choose
the 8 x 10 plot size. Next choose a plot type from the Plot menu. If you are going to make an 8 x
10 plot with labels, then you can also select a font, font size, and style for the labels before
making the plot.

5.11 Labels -
You can select from the Goodies menu for labeling nodes and elements. Other labels (values)
are available by clicking for the following plots:

Boundary Conditions - click on a boundary condition symbol
Node Potentials - click on a contour line
Node Gradients - click on a contour line
Element Potentials- click in an element
Element Gradients - click in an element

You can also change the plot specs, data value range, and number of digits in the labels for
certain plots.

5.12 Labels can be edited -
You can also change the plot specs and data value range for certain plots.

5.20 Zone enlargement -
Select a zone for enlargement using the mouse or switch to multiple zones. If you have
previously selected a zone, then it appears in gray.

5.21 Multiple Zones -
You can divide the plot into multiple, equal-sized zones of button-selected magnifications.
Zones that you have already plotted are marked. The last zone plotted, if applicable, is gray.

5.30 Numeric Label -
Select the format for all following numeric labels. The digit buttons select the number of digits
after the decimal point.

5.40 Range Selection -
You can select a range of data values for your plot. The program calculates the maximum and
minimum values as the defaults. You can change these numbers by entering new values in
the boxes and pressing Return. Since the change of one value affects the other values, you can
only change two of the values at a time which, consequently, affects the third.
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Appendix 2

File Structure

To enable you to more fully utilize the input data, we organized the data files for MacPoisson,
with the exception of the Project Master file, as simple text files. This format makes it possible
for you to edit the data using a word processor or to manipulate the data with another
program. End of lines are denoted by nothing more than a carriage return character (0D16).

Fig A2.1 Library file directory

For greater speed, you can elect to use a binary format for data storage.  Both binary and text
formats can be present on the disk in the same file; see the Library menu for this information.
You can translate the data entry files from one form to the other from the Library menu.

Each project is made up of 19 files altogether. Eighteen of the files are data files containing text.
These files have your project name plus a file extension described below. The remaining file is
the master file which contains the status and dimensions for each of the data files. This file
has your project name.  Files 8-12 for the project shown in Fig A2.1 were not generated in
solve; the “faster” button was selected.
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A2.1 Summary of Data Files

Rec. #  File extension   Item description
 1 .Geom Coordinates of Input Data Points

Region Definitions and Connectivity
Arc Data

2 .Mesh Element Definitions
Mesh Node Coordinates
BandWidth

3 .RMesh Renumbered Element Definitions
Renumbered Mesh Node Coordinates
Renumbered BandWidth

4 .L/B Unique Lines
Boundary Nodes

5 .Prop Material Thermal Properties ‡
Properties *

6 .IBC Input Boundary Condition Specifications
7 .FBC Nodal (Final) D.O.F. Boundary Conditions
8 .IV Initial Heat Source Vector ‡

Initial Source Vector *
9 .IS Initial Global Stiffness Matrix

10 .CC Stiffness Including Convection BC ‡
11 .MV Sources Modified by Temperature BC ‡

Modified Sources *
12 .MS Stiffness Modified by Temperature BC ‡

Modified Stiffness *
13 .NPot Nodal Temperatures ‡

Nodal Potentials †
Nodal Shear Stress Functions **

14 .AveP Average Element Temperatures ‡
Average Element Potentials †
Average Element Stress Functions **

15 .EGrad Temperature Gradients at Elements ‡
Potential Gradients at Elements †
Stress Function Gradients at Elements **

16 .NGrad Temperature Gradients at Nodes ‡
Potential Gradients at Nodes †
Stress Function Gradients at Nodes **

17 .NES Nodal Equivalent Heat Sources ‡
Nodal Equivalent Sources *

18 .FNB Heat Fluxes Normal to Boundaries ‡
Fluxes Normal to Boundaries *

*   for all problem types except Heat
** for Torsion problem type
† for all problem types except Heat and Torsion
‡ for Heat problem type
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A2.2 Structure of Master File

The Master File contains 19 Pascal records of type FileDescrip .

CONST
General = 1;
Torsion = 2;
FluidFlow = 3;
Seepage = 4;
HeatFlow = 5;
Electrostatic = 6;
Magnetostatic = 7;
Gravitational = 8;

TYPE
AxesSystems = ( Planar, Axisymmetric );
PrbTypeRange = General .. Gravitational;
Descrip = ( main, data );
FileName = String[63];
FileDescrip = RECORD

CASE DescType : Descrip OF
main : ( Keyword : String[20];

Description: Str255;
AxesType: AxesSystems;
ProbType : PrbTypeRange );

data  : ( name: FileName;
status : boolean;
DataGroups: integer;
GroupItems: ARRAY [ 1 .. 3 ] OF integer )

END;

The first of these records in the file is of type main. This contains the keyword and description
plus the axes system for the project. The remaining 18 are of type data. Each of these contains
the name of the file, a status flag, and information pertaining to the amount of data in the
files. The status flag is set if the data in the file is valid data.  DataGroups  is the number of
groups of items in the file, which can be a number from 1 to 3. The GroupItems array contains
the number of items in each group.

A2.3 Description of Data Files

Following is a detailed description of the contents of each of the data files. Each can contain
from 1 to 3 "Items," which are groupings of data within the files and which are inter-related
in some way. The groups are further broken down into a "format," which is then given a
description.  Each general description is followed by the data for the bottom heated demo
problem of Chapter 2.
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File 1 - .Geom
Items-

1. Coordinates of Input Data Points
2. Region Definitions and Connectivity
3. Arc Data

Format-
1. x y [ a1 … an ]

.
2. p1 .. p8 cx cy s1 … s4 r c

.
3. t r cx cy f

   p1 … pn
.

Description-

1. x and y = coordinates of point
a1 … an = optional arc numbers

2. p1 … p8 = ccw list of points defining the region
cx and cy = centroid of region
s1 … s4 = the regions connecting each of the four sides
r and c = rows and columns of nodes

3. t = top of rectangle enclosing arc
r = right of rectangle enclosing arc
cx and cy = center of arc
f = c if complete circle; s if semicircle
p1 .. pn = point numbers of points on arc ( at least 2 )

Heated Pot Demo.Geom - Text

A. Coordinates of Input Data Points
B. Region Definitions and Connectivity
C. Arc Data

A1 0 0 
A2 0.15 0 
A3 0 0.3 
A4 0.105 0 
A5 0.165 0.09 
A6 0.1 0.3 
A7 0 0.15 
A8 0.2 0.3 
B1
Æ

1 4 2 5 8 6 3 7 0.09 0.1425 0 0 0 0 8 6 
Ñ

File 2 - .Grid

Items-
1. Element Definitions
2. Grid Node Coordinates
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3. BandWidth
Format-
1. v1 … v3 r

.
2. x y f

.
3. b
Description-
1. v1 … v3 = element vertices

r = region that element belongs to
2. x and y = node coordinates

f = 'i' if node is internal;
‘ b’ if node on boundary of region

3. b = bandwidth

Heated Pot Demo.Mesh - Text

A. Element Definitions
B. Mesh Node Coordinates
C. BandWidth

A1 7 8 2 1 
A2 7 2 1 1 
A3 8 9 3 1 
A4 8 3 2 1 
A5 9 10 4 1 
A6 9 4 3 1 
A7 10 11 5 1 
A8 10 5 4 1 
A9 12 6 11 1 

A10 6 5 11 1 
A11 13 14 8 1 
A12 13 8 7 1 
A13 14 15 9 1 
A14 14 9 8 1 
A15 15 16 10 1 
A16 15 10 9 1 
A17 16 17 11 1 
A18 16 11 10 1 
A19 17 18 12 1 
A20 17 12 11 1 
A21 19 20 14 1 
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A69 48 42 41 1 
A70 47 48 41 1 
B1 0 0.3 b
B2 0.04 0.3 b
B3 0.08 0.3 b
B4 0.12 0.3 b
B5 0.16 0.3 b
B6 0.2 0.3 b
B7 0 0.2571428571429 b
B8 0.0403346938776 0.2512653061224 i
B9 0.0792979591837 0.245387755102 i

B10 0.1168897959184 0.2395102040816 i
B11 0.1531102040816 0.2336326530612 i
B12 0.1879591836735 0.2277551020408 b
B13 0 0.2142857142857 b
B14 0.0409959183673 0.2044897959184 i
B15 0.0792489795918 0.194693877551 i

File 3 - .RGrid
{ same format as  file 2 }

Heated Pot Demo.RMesh - Text

A. Renumbered Element Definitions
B. Renumbered Mesh Node Coordinates
C. Renumbered BandWidth

A1 7 8 2 1 
A2 7 2 1 1 
A3 8 9 3 1 
A4 8 3 2 1 
A5 9 10 4 1 
A6 9 4 3 1 
A7 10 11 5 1 

A69 48 42 41 1 
A70 47 48 41 1 
B1 0 0.3 b
B2 0.04 0.3 b
B3 0.08 0.3 b
B4 0.12 0.3 b
B5 0.16 0.3 b
B6 0.2 0.3 b
B7 0 0.2571428571429 b
B8 0.0403346938776 0.2512653061224 i
B9 0.0792979591837 0.245387755102 i

B10 0.1168897959184 0.2395102040816 i
B11 0.1531102040816 0.2336326530612 i
B12 0.1879591836735 0.2277551020408 b
B13 0 0.2142857142857 b
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B42 0.1522448979592 0.0134693877551 b
B43 0  1.66533453693774e-17 b
B44 0.0492  1.39888101102770e-17 b
B45 0.0888  1.13242748511766e-17 b
B46 0.1188  8.65973959207623e-18 b
B47 0.1392  5.99520433297584e-18 b
B48 0.15  3.33066907387547e-18 b
C1
1

8 
Ä

File 4 - .L/B
Items-

1. Unique Lines
2. Boundary Nodes

Format-
1. e n1 n2

.
2. b

i n e
.

Description-
1. e = element containing line

n1 and n2 = endpoints of line ( renumbered nodes )
2. b = number of separate boundaries

i = indices of beginnings and endings of separate boundaries
n = boundary node number ( numbers are listed ccw )
e = element containing node

Heated Pot Demo.L/B - Text

A. Unique Lines
B. Boundary Nodes

A1 0 7 8 
A2 0 8 2 
A3 0 2 7 
A4 2 2 1 
A5 2 1 7 
A6 0 8 9 
A7 0 9 3 
A8 0 3 8 
A9 4 3 2 

A10 0 9 10 
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A114 0 41 46 
A115 69 48 42 
A116 0 41 48 
A117 70 47 48 

B1 1 
B2 1 2 2 
B3 24 1 2 
B4 0 7 12 
B5 0 13 22 
B6 0 19 32 
B7 0 25 42 
B8 0 31 52 
B9 0 37 62 

B10 0 43 61 

File 5 - .Prop
Items-

Material and Thermal Properties
Properties*

Format-
u
pe1
.
.
pen

Description-
One set of the above format exists for each of the 5
properties.
The properties are:

1. X-conductivity (for General problem type)
    X-Permeability (for Seepage problem type)
    X-Thermal Conductivity (for Heat problem type)
    Shear Modulus (for Torsion problem type)
    Does not apply for the remaining problem types
2. Y-conductivity (for General problem type)
    Y-Permeability (for Seepage problem type)
    Y-Thermal Conductivity (for Heat problem type)
    Does not apply for the remaining problem types
3. Thickness (not used for axisymmetric problems)
4. Heat/Source per unit volume (used only for Heat and General

problem types)
u = uniformity of property

'b' if uniform by body;
'r' if uniform by region;
'e' if uniform by element

pe{n} = property value for element n
If the property is uniform by body then only 1 property
value will be listed in the file.
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Heated Pot Demo.Prop - Text

Material Thermal Properties

1 b
2 4 
3 b
4 4 
5 b
6
Å

1 
$

File 6 - .IBC
Items-

Input Boundary Condition Specifications
Format-

n t d v
.

Description
n = Boundary node number ( not an actual node number, but

an index into the Boundary Node list from file 5 )
t = Type of boundary condition

1 = Node Source (Heat Source for Heat problem type)
2 = Node Potential (Temperature for Heat problem type)
3 = Linear Combination (for General problem type)
       Surface Heat Flux (for Heat problem type)
       Surface Flux (for remaining problem types)

d = Direction of boundary condition
1 = X or R direction
2 = Y or Z direction
3 = normal outward (flux or convection only)
4 = face (flux or convection only)

v = value of boundary condition

Heated Pot Demo.IBC - Text

Input Boundary Condition Specifications

1 43 2 2 30 0 0 
2 44 2 2 30 0 0 
3 45 2 2 30 0 0 
4 46 2 2 30 0 0 
5 47 2 2 30 0 0 
6 48 2 2 30 0 0 
7 48 4 3 100 5 20 
8 42 4 3 100 5 20 
9 36 4 3 100 5 20 

10 30 4 3 100 5 20 

File 7 - .FBC
Items-
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Nodal D.O.F. Boundary Conditions
Format-

t v
.

Description-
One row for each degree of freedom + Boundary Convections + Face

Convections
t = Type of Boundary Condition

0 = No BC for this degree of freedom
1 = Point Source
2 = Potential

v = Value of Boundary Condition

Heated Pot Demo.FBC - Text

Nodal Boundary Conditions

1 0 12 
2 1 0.1675516081867 
3 1 1.00530964912 
4 1 2.01061929824 
5 1 3.01592894736 
6 1 4.02123859648 
7 1 6.855266111011 
8 0 0 
9 0 0 

10 0 0 
11 0 0 
12 0 0 
13 1 8.086610602592 
14 0 0 

File 8 - .IV
Items-

Initial Heat Source Vector values‡
Initial Source Vector values*

Format-
v1
.
.
vn { n = dof }
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Heated Pot Demo.IV - Text

Initial Heat Source Vector

1 0.1675516081867 
2 1.00530964912 
3 2.01061929824 
4 3.01592894736 
5 4.02123859648 
6 6.855266111011 
7 0 
8 0 
9 0 

10 0 
11 0 
12 8.086610602592 

File 9 - .IS
Items-

Initial Global Stiffness Matrix values ( rows x columns )
Format-

v1,1  … v1,b
.
.
vn, 1 … vn, b{ n = dof, b = Bandwidth }

Heated Pot Demo.IS - Text

Initial Global Stiffness Matrix

1 48 8 
2 0.411393126463 -0.2198656851641 0 0 0 0 -0.1915274412989 0 
3 1.9029870755005 -0.8261523999582 0 0 0 -0.054515764156 -0.8024532262222 0 
4 3.9431798055492 -1.6209977958681 0 0 0 -0.1209640749051 -1.3750655348178 0 
5 6.2470431389003 -2.6133786198309 0 0 0 -0.1232841003042 -1.8893826228972 0 
6 8.8779389090917 -3.8346437372384 0 0 0 -0.0180602818139 -2.4118562702085 0 
7 4.7063899610507 0 0 0 0 0.219137612741 -1.0908838365532 0 
8 0.9816703922634 -0.5668989216449 0 0 0 0 -0.1687282651637 0 
9 4.0996616974306 -1.7734273066212 0 0 0 -0.1219142163402 -0.714003951697 0 

10 8.1353346654107 -3.3723154980712 0 0 0 -0.3279792440767 -1.1632629815197 0 

File 10 - .CC
Items-

Stiffness Including Convection BC‡
Format-

v1
.
.
vn { n = dof }
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Heated Pot Demo.CC - Text

Stiffness Including Convection BC

1 48 8 
2 0.4155819166677 -0.2156768949594 0 0 0 0 -0.1915274412989 0 
3 1.9364973971378 -0.8135860293442 0 0 0 -0.054515764156 -0.8024532262222 0 
4 4.0102004488239 -1.6000538448447 0 0 0 -0.1209640749051 -1.3750655348178 0 
5 6.3475741038123 -2.5840570883983 0 0 0 -0.1232841003042 -1.8893826228972 0 
6 9.011980195641 -3.7969446253964 0 0 0 -0.0180602818139 -2.4118562702085 0 
7 4.9370646860266 0 0 0 0 0.219137612741 -1.0164943678206 0 
8 0.9816703922634 -0.5668989216449 0 0 0 0 -0.1687282651637 0 

File 11 - .MV
Items-

Sources Modified by Temperature BC ‡
Modified Sources *

Format-
v1
.
.
vn { n = dof }

Heated Pot Demo.MV - Text

Sources Modified by Temperature BC

1 0.1675516081867 
2 1.00530964912 
3 2.01061929824 
4 3.01592894736 
5 4.02123859648 
6 6.855266111011 
7 0 
8 0 
9 0 

File 12 - .MS
Items-

Stiffness Modified by Temperature BC ( rows x columns )‡
Modified Stiffness ( rows x columns ) *

Format-
v1,1  … v1,b
.
.
vn, 1 … vn, b{ n = dof, b = Bandwidth }
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Heated Pot Demo.MS - Text

Stiffness Modified by Temperature BC

1 48 8 
2 0.4155819166677 -0.2156768949594 0 0 0 0 -0.1915274412989 0 
3 1.9364973971378 -0.8135860293442 0 0 0 -0.054515764156 -0.8024532262222 0 
4 4.0102004488239 -1.6000538448447 0 0 0 -0.1209640749051 -1.3750655348178 0 
5 6.3475741038123 -2.5840570883983 0 0 0 -0.1232841003042 -1.8893826228972 0 
6 9.011980195641 -3.7969446253964 0 0 0 -0.0180602818139 -2.4118562702085 0 
7 4.9370646860266 0 0 0 0 0.219137612741 -1.0164943678206 0 

File 13 - .NPot
Items-

Nodal Temperatures ‡
Nodal Potentials †
Nodal Shear Stress Functions **

Format-
d1
.
.
dn { n = dof }

Heated Pot Demo - Nodal Temperatures

Node Temperature
1
2
3
4
5
6
7
8
9

10
11

24.5093629590423
24.4405598551881
24.3392809476199
24.1926815240246
24.0007233753422
23.7669148249198
24.7840849008712
24.7795692936149
24.7284557773163
24.6307361908547
24.4919393206272

File 14 - .AveP
Items-

Average Element Temperatures ‡
Average Element Potentials †
Average Element Stress Functions **

Format-
e1
.
.
en { n = # of elements }
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Heated Pot Demo - Element Temperatures

El. Temperature
1
2
3
4
5
6
7
8
9

10

24.6680713498914
24.5780025717005
24.6157686728504
24.5198033654743
24.5172911640652
24.4201394163203
24.3744662956080
24.2747136967405
24.1929757236772
24.0865258402964

File 15 - .EGrad
Items-

Temperature Gradients at Elements ‡
Potential Gradients at Elements †
Average Element Stress Functions **

Format-
e1
.
.
en { n = # of elements }

Heated Pot Demo - Element Gradients

El. R Z Magnitude Angle (°)
1
2
3
4
5
6

-1.1267384030595 -6.9639618897502 7.0545236997846 260.8094388810067
-1.7200775963551 -6.4101786426743 6.6369463737837 254.9793583457194
-2.3821877782446 -7.0955229430314 7.4847354292522 251.4414961232700
-2.5319726892050 -6.9736125774775 7.4190402397906 250.0451005601025
-3.7019962059678 -7.0514488707441 7.9641513726020 242.3006192421398
-3.6649855898825 -7.0790325675753 7.9715005781119 242.6283095054023

File 16 - .NGrad
Items-

Temperature Gradients at Nodes ‡
Potential Gradients at Nodes †
Stress Function Gradients at Nodes **

Format-
e1
.
.
en { n = # of elements }
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Heated Pot Demo - Nodal Gradients

Node R Z Magnitude Angle (°)
1
2
3
4
5
6

-1.9576223558528 -5.8793473851214 6.1966935508437 251.5839989822171
-1.7480283387822 -6.1002909723597 6.3457980601843 254.0104319184471
-3.0545237877782 -6.3058822029333 7.0067300452760 244.1547874912678
-4.1250852531261 -6.2496296942142 7.4882708057577 236.5730836629666
-5.2626970883669 -6.1299327461930 8.0791123347033 229.3531036818436
-6.0241868818769 -5.5632389411987 8.2000277502364 222.7219743050786

File 17 - .NES
Items-

Nodal Equivalent Heat Sources ‡
Nodal Equivalent Sources *

Format-
s1
.
.
sn { n = # of nodes }

Heated Pot Demo - Equivalent Sources

Node Value
1
2
3
4
5
6
7
8
9

10

-0.0374893490168
-0.2222223769755
-0.4344344378284
-0.6296833430259
-0.8012072947362
-1.3411236964742

-1.584149478262020e-14
 5.412337245047640e-14
-1.690314554991800e-13
-6.913913885853160e-14

File 18 - .FNB
Items-

Heat Fluxes Normal to Boundaries ‡
Fluxes Normal to Boundaries *

Format-
s1
.
.
sn { n = # of nodes }
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Heated Pot Demo - Fluxes Normal To Boundaries

Bdry Node 1 Node 2 Flux (out)
1
2
3
4
5
6
7
8
9

2 1 25.6407145706972
1 7 -6.8803103854204
7 13 -6.4049259069256
13 19 -7.5055708315804
19 25 -8.6820298009348
25 31 -9.2294613863472
31 37 -8.1847906968428
37 43 -4.7911407160536
43 44 -124.0982890663836
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